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Preface FIX ME!

This preface includes the following sections:

• What’s New in This Release

• About This Manual

• Audience

• Conventions

• Examples
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What’s New in This Release

This section describes the new features, enhancements, and 
changes included in Avanwaves User Guide version 2003.09. 
Unless otherwise noted, you can find additional information about 
these changes later in this book.

New Features

See the HSPICE Release Notes for information about new features 
and last-minute changes.

Known Limitations and Resolved D/Es

Information about known problems and limitations, as well as about 
resolved Defects and Enhancements (D/Es), is available in the 
HSPICE Release Notes in SolvNet. 2003.09 is the last release of 
HSPICE that uses the D/E terminology and numbering system; in 
future releases, these defects and enhancements will be referred to 
as Synopsys Technical Action Requests (STARs).

To see the HSPICE Release Notes:

1. Go to the Synopsys Web page at http://www.synopsys.com and 
click SolvNet.

2. If prompted, enter your user name and password. (If you do not 
have a Synopsys user name and password, click New Synopsys 
User Registration.)

3. Click Release Notes in the Main Navigation section, find the 
2003.09 Release Notes, then open the HSPICE Release Notes.
xiv
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About This Manual

The Avanwaves User Guide describes the AvanWaves tool that you 
can use to display waveforms generated when you simulated your 
circuit designs in HSPICE or Star-SimXT.

Audience

This manual is for circuit designers and engineers who use 
Synopsys circuit simulation tools, including the HSPICE and 
Star-Sim product families.
xv
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Conventions

This manual uses the following conventions.

Commands

SYNTAX:

command_name [argument(s)]

argument types: keyword | value | tag=value | tag=keyword

Command Argument Definition

keyword Keywords are identifiers that must be used as they 
appear. They are shown in base font.

value Values are user-determined. They are shown in italic 
text to distinguish them from commands and 
keywords.

tag=
value
keyword

Tags can be followed by either a value or a keyword. 
Tags and keywords are in the base font. Argument 
values are in italics to distinguish them from 
commands, keywords, and tags. 

Symbol Definition

| A pipe symbol ( | ) represents the word “or” and separates 
choices between two or more arguments. 

... An ellipsis (...) indicates that more than one argument can 
be specified. Ellipses are used only for multiple arguments 
with tags.

[ ] Open and closed square brackets indicate that the 
enclosed argument is optional. 

( ) Open and closed parenthesis indicate that there is a 
choice between the enclosed arguments (two or more). 
These are used only when a command has several groups 
of argument choices; multiple pipe symbols ( | ), in this 
case, would result in an ambiguous syntax.
xvi
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Command Names

Command Names are shown in the same font as the surrounding 
text, but in bold, as shown in the following example.

EXAMPLE 1:

Select the Window >> Set Zoom option to display the Zoom 
Selected Panels dialog window.

File Names

File names are shown in the same font as the surrounding text, but 
in italics.

EXAMPLE 2:

This is an example of a file_name.out being shown in text.

Examples

Examples are shown in a courier font as they might appear on your 
screen.

EXAMPLE 3:

awaves [[-i][-plot][-d] <path><design_name> [-c <config_name>]] 
[ -laf ( windows|openlook|motif ) ]
xvii
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Customer Support

For customer support, use the SolvNet online customer support 
system, or contact the Synopsys Technical Support Center.

Accessing SolvNet

SolvNet includes an electronic knowledge base of technical articles 
and answers to frequently asked questions about Synopsys tools. 
SolvNet also gives you access to a wide range of Synopsys online 
services, including software downloads, documentation on the Web, 
and “Enter a Call With the Support Center.”

To access SolvNet,

1. Go to the SolvNet Web page at http://solvnet.synopsys.com.

2. If prompted, enter your user name and password. (If you do not 
have a Synopsys user name and password, click New Synopsys 
User Registration.)

If you need help using SolvNet, click SolvNet Help in the column on 
the left side of the SolvNet Web page.

Contacting the Synopsys Technical Support Center

If you have problems, questions, or suggestions, you can contact the 
Synopsys Technical Support Center in the following ways:

• To open a call to your local support center from the Web, go to 
http://solvnet.synopsys.com (Synopsys user name and 
password required), then click “Enter a Call With the Support 
Center.”

• Send an e-mail message to support_center@synopsys.com.
xviii
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• Telephone your local support center.

- Call (800) 245-8005 from within the continental United States.

- Call (650) 584-4200 from Canada.

- Find other local support center telephone numbers at 
http://www.synopsys.com/support/support_ctr.
xix
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1
Introducing AvanWaves 1

This chapter introduces you to the AvanWaves product, and 
describes the features available and the input files utilized. 

AvanWaves is available on Unix and PC platforms only.
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Features

AvanWaves provides a convenient graphical interface to display, 
analyze, and print the results of HSPICE simulations. This version of 
AvanWaves enables you to

• Load all files associated with a particular design in one step

• Open multiple designs simultaneously

• Update an existing design with information obtained from a new 
simulation run

• Superimpose results with two different data types within one 
graph, using up to two different Y-axes 

• Build algebraic expressions and macros to modify and combine 
simulation results for display 

• Graph (without limitations) simulation results or for displaying 
panels

• Interactively measure and label data on waveforms

• Save and restore all aspects of a particular design analysis as a 
configuration

• Look at individual parametric variations using the Sweep Filter

• Produce hard copy prints of the design analysis and results 
display 

• Access online Help

• Run HSPICE within the waveform analysis section
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Design Flow

Figure 1-1 shows the design flow diagram for AvanWaves.

Figure 1-1 AvanWaves Design Flow Diagram

Open Design

Select Analysis

Graph 
Results

Build Expressions
and Macros

Open Configuration File

PrintMeasure

Save  Configuration File

Review Simulation 
Data Available
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Input Files

HSPICE run files and configuration files saved during a AvanWaves 
session are used as input to AvanWaves. The configuration file is 
located in a directory having the same name as your current design 
with a .sav extension. The configuration file is located in the 
<design_name>.sav directory and has a .cfg extension.

Table 1-1 lists the HSPICE run files used as input to AvanWaves.

Output Files

AvanWaves can save all design data, analyses and waveforms 
created to display the data in a “configuration”. You can save each 
configuration to a configuration file with a unique name, in the form 

<config name>.cfg, in the<design>.sav. directory

Table 1-1 Files used as input to AvanWaves

Design File Name Description
<design>.sp HSPICE input netlist
<design>.st# Status file
<design>.pa# Subcircuit cross-listing file
<design>.lis Output listing file
<design>.tr# Transient analysis results
<design>.mt# Transient measure data file. An associated <design>.tr# 

file must exist for this file to be current
<design>.ac# AC analysis results
<design>.ma# AC analysis measurement results
<design>.sw# DC analysis results
<design>.ms# DC analysis measurement results
<design>.xp# Transient analysis results
<design>.cm# Transient analysis results
<design>.wv# Transient analysis results
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Directory Structure

Figure 1-2 shows the directory structure for AvanWaves.

Table 1-2 Directory Structure

Design dir

<design>.sav

<config>.cfg <config>.cfg <config>.cfg

Sim. output
.lis

Measures
.mt#,.ma#,.ms#

Raw output
.tr#,.ac#,.sw#

Sim. input
*.sp
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2
Getting Started 2

This chapter provides some simple procedures to help you 
understand and use the basic functions of AvanWaves. 
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Starting AvanWaves
1. Set up your demo environment Change directory to 

$installdir/demo/awaves.

2. Load AvanWaves.

You can run AvanWaves under different window manager 
environments:

- Using Motif

Motif is the default environment for AvanWaves. To start 
AvanWaves on the command line from any directory, type:

awaves 

For backward compatibility, you can also type mwaves to start 
AvanWaves.

- Using other window manager environments 

Start AvanWaves on the command line from any directory, 
specifying the window manager that you are using, as follows:

awaves -laf [windows|openlook|motif] 

The AvanWaves application is loaded and the Results Display 
window is displayed under the selected window manager. 

Note: This user guide describes AvanWaves behavior under the 
Motif window manager (default). You will see some 
differences in user interface appearance and functionality for 
the other window managers. 

Invoking AvanWaves on page 4-2 lists all invocation options.
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Using AvanWaves
The following example demonstrates how to use AvanWaves to 
analyze the results of an HSPICE DC analysis for a MOS device, 
displaying a family of I vs. V curves. The example uses the design 
mosiv.sp, in the $installdir/demo/awaves/tutorial/dc directory.

Opening the Design

To open the mosiv.sp design:

1. In the Results Display window, select the Design >> Open 
command, using the right mouse button. 

The Open Design window appears. 

2. In the Open text area, enter the following design file path name:

$installdir/awaves/tutorial/dc/mosiv.sp

3. Click on OK with the left mouse button. 

The Results Browser opens as shown in Figure 2-1, listing the 
analysis files for the design. 
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Figure 2-1 Results Browser 

Selecting the Analysis Files

The analysis is set up by selecting an analysis file and an analysis 
type, as follows:

1. In the Results Browser, select the DC analysis, sw0. 

This is the file to be used in the analysis.

2. In the Types scroll box, select the analysis data type Currents.

A list of all curves associated with the selected data type is 
displayed in the Curves scroll box.
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Displaying a Waveform

Waveforms display in the Results Display window. One panel opens 
by default when you open this window. To display the waveform 
associated with the i(mvg2 curve:

• In the Curves section of the Results Browser, select the curve 
i(mvg2 with the left mouse button. Use the middle mouse button 
to drag and drop it into the panel in the Results Display window.

The selected waveform displays, as shown in Figure 2-2. 

• As an alternative way of displaying the waveform:

1. Click on the panel where you want the curve to display. 

2. In the Results Browser, double-click on the name of the 
curve. 

The selected curve waveform displays in the selected panel. 

Figure 2-2 i(mvg2 curve Displayed in the Results Display window
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Adding a New Panel

You can open several panels in the Results Display window at the 
same time, for comparisons. To add a new panel to the Results 
Display window, select Add from the Panels pulldown menu. 

A new panel is added to the Display area, as shown in Figure 2-3. 
Panels are automatically named as they are added.

Figure 2-3 Results Display Window with Addition of New Panel

The number of panels in the Results Display Window is limited only 
by the size of the Results Display window. If the window is too small, 
this message displays when you select Add from the Panels menu.

Not enough room to display new panel. Added as hidden panel.

The panel is added to the Panel List within the Panels pulldown 
menu as a hidden panel. To display the panel, increase the size of 
the Results Display window, then double-click on the hidden panel. 
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Displaying a Second Waveform

To display a second waveform in the new panel:

1. Click the L mouse button in the new panel to select it. 

2. In the Results Browser, select the DC analysis sw1.

3. In the Types section, select the analysis data type Currents.

4. In the Curves section of the Results Browser, select i(mvg2 
using the L mouse button, then double click the L mouse button 
to produce the curve in the selected display panel, as shown in 
Figure 2-4. Alternatively, you can drag the selected curve into the 
panel in the Results Display window using:

- L mouse button (OpenLook desktop)

- middle mouse button (Motif desktop)

To delete a waveform in a panel, select the waveform in the wave list 
and press Del.

Figure 2-4 Two curves displayed in two panels
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Summary

The example used throughout this chapter described how to open a 
design, select analysis files to evaluate, add panels, then display 
waveforms. These are the basic functions provided by AvanWaves. 
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3
Working With Designs 3

A design is the collective information that describes your circuit, such 
as the netlist, the analysis files, and the simulation graph data files. 
This chapter describes the operations you can perform in 
AvanWaves using the Design menu. This includes opening, closing, 
and saving designs.
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Open Design Window

The Open Design window shown in Figure 3-1 allows you to open 
one or more designs in AvanWaves. The window has a menu bar 
with four menus, a pop-up directory selector button, lists of 
directories and files, scrolling buttons for the lists, and an Open field.

To select a directory, click and hold down the pop-up directory 
selector button, and slide the selector to the directory name. The left-
hand list shows the contents of the directory you select. If the item 
selected in the left-hand list is a directory, the contents of that 
directory are shown in the right-hand list.

Figure 3-1 Open Design Window
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To open a design:

1. From the results display window, select Design >> Open.

2. In the Open Design window directory selector pop-up menu, 
select the directory that contains the design you want to open. 
This is the run directory.

3. If the design file is in a subdirectory of the run directory, select the 
subdirectory in the left-hand list area in the Open Design window.

4. In the right-hand list area, select the simulation file you want to 
open.

5. On opening the design, AvanWaves collects all of the files 
associated with this design (the HSPICE input and output files and 
the other associated files having the same design root name) from 
the path specified. 

You can navigate through the directory structure in the following ways:

• Enter a path and design name into the Open field in the dialog box.

• Double click on a directory to display its contents.

- Use the < button to select the parent directory or use the > 
button to select a subdirectory.

- In the History menu, select designs that you previously visited.

• Select a path from the pop-up menu. This menu always contains 
the name of your current directory.

To open the design, double click on the design name or select the 
design from the file list displayed, and then click OK or Apply.
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Selecting Menus

The following selections can be made in the Open Design window:

History Menu

Select the History menu to get a list of the paths to designs 
previously visited in this AvanWaves session. The maximum number 
of paths that can be displayed is five. The first item in the list is the 
path to the current design. Selecting one of the paths from this list 
opens the selected design and close the currently-active design. The 
History list is updated whenever you use the Special >> Mark or 
Special >> Unmark command.

Special Menu

Select the Special menu to:

• Return to your home directory

• Mark a directory location for permanent entry in the History list

• Remove the current directory location from the marked list

View

Select the View opt ion to change the order in which file names are 
displayed in the file list. You can display files:

• by Name — Lists the files by name in alphabetical order

• by Date Modified — Lists the files according to the last date they 
were modified

• by Date Created— Lists the files by the date created
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Filter Menu

Select the Filter menu to limit the number of files selected by 
selecting the types of files displayed in the file list. There  is a file 
extensions submenu that lets you specify the default extension to the 
HSPICE input netlist (defaults to *.sp). The Filter menu lists six types 
of files, with a button for each type. When a button for a file type is 
clicked, that type of file is selected for display. A button that is not 
depressed means that type of file is not selected. 

You can select any combination of file types.

Table 3-1 File Types in the Filter Menu

File Type Description

Input Display input files only

Listing Display listing files only

Raw Output Display raw data files only (HSPICE graph data files: *.tr0, 
*.ac0, *.sw0, *.cw, *.wv, *.xp)

Measures Display measure data files only (*.mt0, *.ma0)

All Files Display all the files in the current directory

Options Display the filename extensions for input and history files
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Buttons

Accepted File Types

Design files are HSPICE simulation input or output files that are used 
as input to AvanWaves. You can open a design file by specifying the 
path to the design files, then selecting the file type on the Filter 
menu. AvanWaves accepts these file types:

Table 3-2 Open Design Window Buttons

Button Description

OK Click OK after selecting the design from the list to open the 
design and close the Open Design window.

Apply Click Apply after selecting the design from the list to open 
the design without closing the Open Design window. To 
close the Open Design window, you must click Cancel.

Cancel Click Cancel to cancel the current operation and close the 
Open Design window.

Help Click Help to get the AvanWaves on-line Help on the 
current dialog box.

Table 3-3 File Types in AvanWaves

Design File Name Description

<design>.sp HSPICE input netlist

<design>.st0 status file

<design>.lis output listing file

<design>.tr# raw transient simulation output data

<design>.sw# DC analysis graph data file

<design>.ac# AC analysis graph data file

<design>.mt# transient measure data file. An associated 
design.tr# file must exist for this file to be current.

<design>.ms# DC measure data file. An associated design.sw# 
file must exist for this file to be current.
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Close Design Window
The Close Design window lists all designs you have opened in your 
current AvanWaves session. To close a design:

1. From the Results Display window, Select Design >> Close. The 
Close Design window appears, as shown in Figure 3-2.

2. Select the design that you want to close, then click OK or Apply. 
Double clicking the design has the same effect as clicking Apply.

Figure 3-2 Close Design

<design>.ma# AC measure data file. An associated design.ac# file 
must exist for this file to be current.

<design>.cw# Transient output data from Star-SimXT.

<design>.wv# Transient output data from Star-SimXT.

<design>.xp# Transient output data from Star-SimXT.

Table 3-4 Close Design Windows Buttons

Button Description

OK After selecting the design from the list, click OK to close the design. This removes 
the design from the current session and closes the Close Design window. 

Apply After selecting the design from the list, click Apply to close the design. This 
removes the design from the current session. You must click Cancel to close the 
Close Design window.

Cancel Click Cancel to cancel the current operation and close the Close Design window.

Help Click Help to get the AvanWaves on-line Help on the current dialog box.

Table 3-3 File Types in AvanWaves (Continued)

Design File Name Description
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Current Design Window
The Current Design window lists all open designs in your current 
AvanWaves session. It provides the full path to the design. You can 
select a new current design from the designs list. Setting the current 
design refreshes the Results Browser with current design data.

Designs are represented by design numbers D0 through Dn. The 
design number identifies your design and is referenced throughout 
the application. It is used to identify displayed waveforms.

To select a new current design:

1. Select Design >> Current from the Results display window. The 
Current Design window appears, as shown in Figure 3-3.

2. Select a design.

3. Click OK or Apply.

Figure 3-3 Current Design

Table 3-5 Current Design Window Buttons

Button Description

OK Click OK after viewing the current design or after selecting a new current design. 
The new design is automatically loaded into AvanWaves. Double clicking on the 
design has the same effect as clicking OK.

Apply Click Apply to apply any changes you made. If you selected a new design, the new 
design is brought in as your current design. You must click Cancel to close the 
Close Design window.

Cancel Click Cancel to cancel the current operation and close the Current Design window.

Help Click Help to get the AvanWaves on-line Help on the current dialog box.
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Exiting the Design

To close the design and quit AvanWaves, do the following:

1. Select Design >> Exit in the Results Display window. 

The Exit AvanWaves dialog box is displayed. You are given the 
option of saving your current design configuration before quitting. 
Refer to  Chapter 7, “Using Configurations” for information about 
saving and restoring AvanWaves configurations.

2. To save your design configuration, click Save. 

The Save Configuration dialog appears.

3. Enter the name of the configuration, then click Save in the Save 
Configuration dialog. This saves your design to the 
configuration specified, and then exits the AvanWaves 
application.
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4
AvanWaves User Interface 4

This chapter describes the AvanWaves user interface, which 
includes the command line invocation, mouse operations, and the 
menus and tools used to perform operations on the simulation 
results. A list of keyboard shortcuts also is provided for the most 
commonly used commands. 
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Invoking AvanWaves
AvanWaves is invoked on the command line using different options. 
The full command line syntax is:

awaves [[-i][-plot][-d] <path><design_name> [-c <config_name>]] 
[ -laf ( windows|openlook|motif ) ]

After you invoke the awaves command, the copyright information 
appears first, as shown in Figure 4-1, then is replaced with the 
Results Display window.

Table 4-1 AvanWaves Options

Option Description

-d <design_name> Name of the design to open on invoking AvanWaves. Use HSPICE file 
extensions to specify the design name, such as .sp, .lis, .tr0, .tr1, .tr2,
.ac0, .ac1, .ac2. An example of a design name is design1.sp.

-c <config_name> Specifies that a previously saved configuration for the current design is to 
be used upon the initialization of AvanWaves. The -d option with the 
design name corresponding to the configuration name must be specified 
on the command line. 

For example, if D1.sav/BodePlot.cfg is saved in a previous session, then 
to open the design and the saved configuration you can use one of the 
following command line options:

awaves -d D1 -c BodePlot

awaves -d /mytop/D1 -c BodePlot
laf [windows|openlook|motif]

Specifies the window manager style to use. Default is Motif.

-i Directly open the “Awaves Command User Interface” windows when you 
open awaves.

-plot When you open awaves, the plot mode is Continuous. The default plot 
mode is Monotonic.
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Figure 4-1 AvanWaves Copyright Information

Using the Mouse
Use the mouse to select items and menu options. Table 4-2 
describes the use of the mouse buttons for Motif UNIX system users.

Table 4-2 Using Mouse Buttons with AvanWaves

Select item (“click”) Click the left mouse button on the item to select it. This mouse button 
performs operations inside panels, such as measures and zooming.

Select menu 
(“select”)

Use the right mouse button to select from a menu, including context-
sensitive menus.

Double-click Using the left mouse button, click twice on the item to select or display. 
This action opens or expands an item.

Drag and drop Using the left mouse button, click on the item to select it. Then press and 
hold down the middle mouse button while dragging the selected item. 
Release the button when the item is in the desired location.

Multi-select While pressing Control, click on the desired items one after the other with 
the left mouse button. The group of items is selected. 

Range select Hold down the left mouse button and drag the mouse over the required 
range, then release the mouse button.
4-3

AvanWaves User Interface: Using the Mouse



Tools
Table 4-3 lists tools available in the AvanWaves user interface.

Results Browser 

The Results Browser lists all available HSPICE simulation data for 
the current design, by analysis type. 

Figure 4-2 Results Browser

Table 4-3 AvanWaves Tools

Tool Description

Results Browser Displays available analysis files and types for a particular design

Results Display window Main window; displays waveforms and related information

Expression Handler Creates expressions for analyzing simulation results

Macro Builder Dialog box for creating macros to use in your expressions

Print Controls printing of the contents of a panel

Preferences Sets general application preferences such as foreground and 
background color, font, and waveform display attributes

Sweep Filter Dialog box for selecting parameters for displaying waveforms
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The next sections describe the components of the Results Browser.

Current Design Field and Scroll List

The path to the current design is displayed in this field at the top of 
the Results Browser. An analysis label tr0 through trn, ac0 through 
acn, sw0 through swn, is associated with each set of analysis data 
for the current design and displayed in the scroll list. Each analysis 
label is followed by a description consisting of a simulation type and 
title. The title is derived from the first line of the input file to HSPICE 
or the title specified on the .ALTER statement.

To select an analysis, click on the description associated with its 
label. The types of data available for the current analysis are listed 
in the Types area of the window, and the variable names are listed in 
the Curves area. You can change the contents of the Curves field by 
selecting other analyses in the Types list.

Hierarchy Browser Scroll List

You can use the Hierarchy Browser to reduce the number of nodes 
that you see during curve selection in the Results Browser window. 
The Hierarchy Browser is a listbox in the Result Browser, as shown 
in Figure 4-3. This box displays the subcircuit hierarchy of a design. 
AvanWaves reads hierarchy information from either the <design>.lis 
or <design>.pa0 output files from the HSPICE run. Not all circuits 
have a subcircuit hierarchy. If there is no hierarchy in the design, the 
hierarchy window is blank.

Subcircuits are shown in the form “instance_name: cell_name” if 
the .lis file is available. If only the .pa0 file is available, only the 
instance name is shown. The .pa0 file does not contain cell names.
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You can perform two types of operations with the hierarchy window.

• Subcircuit hierarchies may be turned on and off by double 
clicking the parent.

• The set of subcircuits from which nodes are displayed is chosen 
by selecting subcircuits in the hierarchy window. Multiple 
subcircuits can be chosen by using the Multi-select or Range 
select features (see Using the Mouse on page 4-3).

Figure 4-3 Hierarchy Browser with Multiple Subcircuits Selected

Types Scroll List

The Types list displays the types of data available in your current 
analysis. Selecting the data type changes the contents of the 
Curves list to indicate the data available.

Click on one of the Types in the list to select it.
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Curves Scroll List

The Curves area lists the data that is available for a selected type of 
analysis. After you select a data type in the Types area, a list of 
available data is displayed in the Curves scroll list.

To display the waveform for the curves, do either of the following:

• Select the required curves and drag the selections into a panel.

• Double-clicking on a node to display it in the selected panel.

Current X-Axis Selector

The Current X-Axis represents the variable and units to be used on 
the horizontal axis to display the waveform in the panel. The default 
X-Axis is the first independent variable in the Types list. You can 
modify or change your X-Axis variable as follows:

1. Drag a curve from the Curves section into the Current X-Axis 
box.

2. Select a curve and click Apply in the Current X-Axis box.

The X-Axis used with this curve is now used as the Current X-
Axis variable for the selected curve.

3. Click Default. This resets the value to the default value.

The default value is the first variable in the Types list.

Filter Selector

The Filter selects data points based on criteria you enter for 
displaying in the Curves area. You can enter your selection criteria in 
the Filter field. Regular UNIX expressions ( *, . ) are accepted. Click 
Apply to apply your selection as a filter for the curves. Click Reset 
to display the default values in the curves area for your analysis.
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Results Display Window

The Results Display window is the primary application window 
containing the menus, options, functions, and tools that you need to 
perform your simulation analysis. The Results Display window 
contains these components:

• Menu bar

• Speed bar

• Panel(s)

• Wave List

• Context-sensitive menus

The components of the Results Display window are described in 
the following sections. 

Figure 4-4 Results Display Window

The Window banner conforms to the standards of the resident 
window manager for your machine, such as Motif or OpenLook. 
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Menu Bar 

The Menu bar is located at the top of the Results Display window 
and contains six pull-down menus and a Help button. 

Figure 4-5 Menu Bar 

The Menu bar contains these pop-up menus:

The speed bar is located between the menu bar and the panel. It 
contains the following two types of items:

• Accelerator icons are used to make a quick selection of the 
Results Browser, Expression Handler, and Print functions. To 
select a function, click on the icon representing the function to 
open the associated dialog box. 

• The X-Y coordinate display is used to display the position of the 
cursor during a measure operation. The X and Y coordinates of 
the cursor, shown on a waveform by the measure markers, are 
displayed in the boxes. 

Table 4-4 Speed Bar Menu

Option Description

Design Use to open and close a design, exit from a design, 
and display your current design.

Panels Adds, deletes, hides and updates panels.

Window Performs zooming and panning operations. These 
operations change the view in the panel.

Measure Performs point or point-to-point measurements on 
waveforms and deletes measurements.

Configuration Opens, saves, and deletes configurations.

Tools Provides tools to perform analyses of your design.

Help Provides on-line Help for AvanWaves.
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Figure 4-6 Speed Bar

Panel 

Panels contain waveform displays in the AvanWaves Results 
Display window. A panel consists of a panel name, a Waveform 
Display area, an X-Axis and a Y-Axis, and a Wave List. The 
waveforms can be raw simulation data, measurements, or results of 
an analysis using expressions and operations on simulation data. A 
panel also has two context-sensitive pop-up menus associated with 
it. Panels can be added to or deleted from the Results Display 
window. Panels can be switched from one view type to another. You 
can save all information and status of a panel in a “configuration.” 

Result Browser

Expression Builder

Print Manager

One Point Measure

Two Points Measure

Zoom In X/Y

Zoom In X

Zoom In Y

Zoom Out X/Y

Zoom Out X

Zoom Out Y

Cancel previous click operation
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Figure 4-7 Panel

Table 4-5 Panel Components

Component Description

Panel name Each new panel is opened with a default panel name such as 
‘Panel 1’. You can change the panel name by deleting the default 
name and typing a new one. Panel names are displayed in the 
Panel List in the Panel pull-down menu. To delete a particular 
panel, select the panel name and click the Delete key.

Waveform Display area the display area inside the panel where simulation data and 
analyses are displayed.

X-Axis The horizontal X-Axis and its units display when the panel shows 
waveform data. A context-sensitive menu is associated with this 
axis. You can select this menu by pressing the right mouse button 
on the X-Axis. You can change the scale of the X-Axis display.

Y-Axis The vertical Y-Axis and its units display when the panel shows 
waveform data. A context-sensitive menu is associated with this 
axis. You can select this menu by pressing the right mouse button 
on the Y-Axis. You can change the scale of the Y-Axis display. 

x1=1.45e+06
Y1=6.39e+01
Delta X=0.00e+00
Delta Y=6.47e+01
Slope=infinity

180
160

140

100

120

80

60

40

20

0

-20

V
ol

ts
 P

ha
se

 (
lin

)

Frequency (log)(Hertz)1 10 100 1k 10k 100k 1x 10x

0

150

50 V
ol

ts
 d

B
 (

lin
)100
4-11

AvanWaves User Interface: Tools



Each waveform has a unique color associated with it as an identifier. 
The color used in the waveform is the same color used to identify it 
in the Wave List. There is a standard set of colors assigned to 
waveforms as they are added to a display. The color set can be 
modified through the Preference option on the Tools menu. 

You can use eight different colors at a time from a set of 16 colors. 
Waveform names can be no longer than sixteen characters in length, 
according to the HSPICE limit for relative waveform names.

Panels also can be hidden from view. If the number of panels 
displayed has reached the limit of eight, then each new panel above 
the maximum number is added to the Panel List as a hidden panel. 
Hidden panels are grayed out in the list. Panels currently displayed 
are highlighted in the list. To display a hidden panel, one of the 
panels currently displayed must either be hidden or deleted. These 
operations can be selected from the panels menu.

Note: You must select a panel by clicking in the panel before you 
perform an operation on it. A number of panels may be 
selected at a time by holding down the Control key while 
selecting the panels. 

Add Label

Use the Panels >> Add Label utility to add your own labels to 
waveforms:

1. Click the left mouse button on Add Label, or type Ctrl-L, to 
display the Label Name dialog window.

2. Type your label into the Label: field of the Label Name window.
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3. Click Apply to preserve the Label Name window if you want to 
apply another label after this one. Click OK If your label is either 
singular, or the last one of a set. When you move your cursor into 
the waveform display area, AvanWaves displays your label with 
your cursor arrow.

4. Click the left mouse button to place the label in any position in the 
display area.

Delete Label

Delete labels using Panels >> Delete Label. Select the label by 
clicking on it with the left mouse button and then click on Delete 
Label, or type Ctrl-2, to delete it.

Wave List

The Wave List is located on the left side of the Results Display 
window associated with each panel. All waveforms currently 
displayed in the waveform display area of the panel are listed. You 
can scroll through the Wave List if not all waveform names are 
visible.

Context-Sensitive Menus

Context-sensitive menus are pop-up menus that are available in a 
particular area of the panel. That is, a particular pop-up menu 
appears depending on the location of the cursor in the window. The 
areas that have context-sensitive menus in the Results Display 
window are the X-Axis, the Y-Axis, and inside the waveform display 
area. Activate the context-sensitive menus by clicking in the context-
sensitive area with the right mouse button.
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Figure 4-8 Context-Sensitive Menus

Context-Sensitive Menus in X-Axis and Y-Axis Areas

The context-sensitive menus for the X-Axis and Y-Axis provide the 
option to change the scale used in the graph area. Select this option 
to display a dialog box with toggle buttons from which you can 
choose a Linear or Logarithmic scale. Select the scale you want 
with any of the mouse buttons, then click Apply to enforce it.

Font…

Scale…

Full

Zoom

Set Zoom…

Pan

Set Pan…

Set Grid...

Monotonic Plot…

Hide Title Bar

Grid Off

Sweep Filter

Measure Preferences...

Stacked Mode

Zoom In X

Zoom Out X

Zoom In Y

Zoom Out Y

Zoom In X/Y

Pan X

Pan Y

Pan X/Y

In X- and Y-Axis areas In waveform display areas 
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Context-Sensitive Menus in Waveform Display Areas 

The context-sensitive menu for the waveform display area provides 
all the options available on the Window menu in the main menu bar, 
in addition to the following options:

For further information about these commands, see the Command 
Summary section in Appendix A.

Expression Builder

You can use the Expression Builder to create expressions 
containing functions, variables, operators, and macros. Expressions 
are given names and added to the Expressions list. 

Enter the Expression Builder by selecting Tools >> Expressions 
from the Results Display window.

Table 4-6 Context-Sensitive Menu Options

Option Description

Set Zoom Calls up a dialog box in which you can set values for zooming. The 
X-Axis and Y-Axis scales are defined here. You can set specific 
zooming options, having minimum and maximum values.

Set Pan Calls up the Set Local Pan dialog box where you can set values 
for local panning. You can enter values for your axis here.

Monotonic/Continuous 
Plot

Alters the display of your waveform.

Grid On/Off Enables you to turn grid line on and off in the panel.

Sweep Filter Selects the data set to be displayed.

Measure Preference Enables you to set the preferences for performing measure 
operations.

Stacked Mode Displays curves one above the other with each having its own Y-
Axis, rather than overlaying the curves on a single Y-Axis.
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Figure 4-9 Expression Builder

Macros also can be created and are added to the Macros list. The 
results of evaluating expressions can be displayed as waveforms in 
the Results Display window. 

The next sections describe the components of the Expression 
Builder window:

Expression Field

Enter the text for an expression in the Expression field. An 
expression consists of functions, macros, arguments, and operators. 
Variables can be selected from the simulation results found in the 
Curves section of the Results Browser. You can use expressions to 
build more complex expressions.
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Result Field

Enter a name for the expression in the Result field. The expression 
is saved under this name so that it can be used later. The name is 
added to the Expressions list.

Clear Button

Clears the Expression field and the Result field. 

Functions List

The Functions list shows all the system-defined functions that are 
available for use in creating expressions and macros. Appendix B 
describes the functions and operators available in AvanWaves.

Operators List

The Operators list shows all the predefined operators that are 
available for use in building expressions and macros in AvanWaves. 
The following are the types of operators:

• Arithmetic (+, -, *, /) — return analog waveforms 

• Comparison (>, <, <=, >=, !=, ==) — return logical waveform 
results (1 or 0)

• Boolean combination (&&, ||, !) — return logical waveform results 
(1 or 0)

• Conditional (expr1 ? expr2 : expr3) — analog value (first 
parameter is logical)

Expressions List

The Expressions list shows all user-defined expressions.
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Macros List

The Macros list shows all the macros created or loaded into 
AvanWaves. You can select macros from this list, to use in 
expressions, the same way that functions are used in expressions.

Buttons

Options Menu

The Options pop-up menu provides options for adding, editing, 
loading, and saving user-defined functions for expressions. The 
following options are available in the Macro pop-up menu:

Table 4-7 Expression Builder Buttons

Button Description

Option Displays the Options Menu

Help Click Help to get on-line Help for the current window.

Cancel Click Cancel to cancel the current operations.

Apply Click Apply to apply the changes to the expressions and macros.

Table 4-8 Options Menu

Option Description

Options >> Add Macro Creates a new macro and adds it to the Macros list.

Options >> Edit Macros Enables you to edit the macro that is currently 
selected in the Macros list.

Options >> Load Macros Loads previously defined macros into the Macros 
list to be used in creating expressions.

Options >> Save Macros Saves the current macro to a file.

Options >> Delete Expression Removes the specified expression.
4-18

AvanWaves User Interface: Tools



Add/Edit Macro Dialog

The Add Macro dialog is used to add macros to the Macros list in 
the Expression Builder window. These macros can be used later in 
expressions.

The Edit Macro dialog is used to edit previously defined macros. A 
macro must be selected from the list of available macros in the 
Expression Builder window before selecting this option. The macro 
selected for editing is displayed in the Edit Macro dialog when the 
dialog opens. 

The Edit Macro dialog has the same user interface as the Add 
Macro dialog. The following is the user interface for both options.

Figure 4-10 Add/Edit Macro Dialog
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Load/Save Macro Dialog

The Load Macro function is used to load previously saved macros 
into the Macros list. To save macros, use a .mac extension.

Note: To load a macro that you have saved using a different 
extension you must select the Filter >> All Files option in the 
Load Macros dialog to display all the files in the list.

The Save Macro dialog allows you to save the macros that you 
created during the current session to a file. This allows you to load 
and use them in another AvanWaves session with other designs.

Table 4-9 Components in Add Macro/Edit Macro Dialog

Component Description

Macro Head Enter the name of the macro that you want to define, along 
with its arguments in this text entry field. 

Macro Body The macro body is made up of any number of functions and 
operators available in the Functions and Operators lists in the 
Expression Builder window. Expressions are entered into 
the Macro Body. The expressions entered into the Macro 
Body may be entered on separate lines and are concatenated 
into one expression using the operators. 

Notes Enter comments on a macro in this text entry field.

Table 4-10 Add/Edit Macro Buttons

Button Description

OK Click OK to add the macro to the Macros list in the 
Expression Builder window.

Cancel Click Cancel to cancel the operation.

Help Click Help to view on-line Help about the current dialog.
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The Load Macro dialog has the same user interface as the Save 
Macro dialog. The user interface for both options is described below.

Figure 4-11 Load/Save Macro Dialog

The components of the Load Macro and Save Macro dialogs are 
described below.

Load Macros/Save Macros Menus

History

Select this menu item to get a list of the most recent paths used for 
loading or saving macros. Select one of the paths from this list to 
load a macro contained in the path or to save a macro to a file at that 
location. The History list is updated each time you load or save a 
macro, and it is saved between AvanWaves sessions. The default 
path is that from which you started the AvanWaves application.
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Special

Use this menu with the History menu.

View

The View option selects the order in which file names display in the 
file list.

Filter

The Filter option allows you to limit the number of files displayed by 
selecting the file types in the File List. The menu has two buttons. A 
button that has been clicked marks a selection. A button that is not 
depressed means that it has not been selected 

Table 4-11 Special Menu

Option Description

Home Returns you to your home directory.

Mark Marks a directory location for the history list.

Unmark Removes the current directory location from the marked list.

Table 4-12 View Menu

Option Description

by name Lists the files in alphabetical order by name.

by date modified Lists the files according to the last date they were modified.

by date created Lists the files by the date created.

Table 4-13 Filter Menu

Option Description

Macro Definitions Display macro files only.

All Files Display all the files in the current directory.
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Open/Save Field

Open/Save is a text field where you can enter the path to the file you 
want to open or enter a location where you can save the macro. 

Buttons

Sweep Filter

In AvanWaves, a sweep is a set of response data with a variation in 
the value of one of the parameters, such as voltage, resistance, or 
temperature. To analyze designs, you can select and display a set of 
output data from HSPICE simulations (“sweeps”). 

The Sweep Filter is used to display the values of a variable for its 
changing parameters. Sweep increments are displayed on a panel-
by-panel basis. The title in the Sweep Filter dialog shows the name 
of the panel to which the sweeps belong.

Figure 4-12 Sweep Filter

Table 4-14 Load Macros/Save Macros Buttons

Button Description

OK Click OK to apply the selection and close the Macro Definitions window.

Apply Click Apply to apply the selection.

Cancel Click Cancel to cancel the current operation.

Help Click Help to view on-line Help about the current dialog.

Swept
increment

Toggle
button

Sweep display 
area
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The display area of the filter shows the sweep increments associated 
with a particular waveform in the current design. 

The first entry in the first column in the display area acts as a toggle 
for selecting or deselecting the sweep increments in the adjoining 
row. The sweep increments can be selected individually by clicking 
on them using the left mouse button. The sweep increments also can 
be selected in groups by holding the Control button down while 
selecting each one using the left mouse button. 

Print Dialog

The Print dialog window allows you to print the waveforms displayed 
in the panels, along with the measurement data and any labels 
annotating the waveform. Both open and hidden panels can be 
printed.

Table 4-15 Sweep Filter Buttons

Button Description

OK Click OK after selecting the sweep(s) you want to display. This displays the 
sweep(s) in the waveform display area of the panel and closes the Sweep Filter.

Apply Click Apply after selecting the sweeps from the list to display them in a panel. 
You must click OK or press Return to close the Sweep Filter.

Cancel Click Cancel to cancel the current operation. The Sweep Filter closes.

Help Click Help to view the AvanWaves on-line Help about the current dialog box.
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Figure 4-13 Print Dialog with Print to Printer Selection

Figure 4-14 Print Dialog with Print to File Selection
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Print

To make printing selections, click on the buttons in the Print dialog:

Table 4-16 Print Menu

Option Description

Panels Click All to print all the panels, including the panels in the Results 
Display area, as well as the hidden panels. 

Click Selected to print panels that you have selected from the Results 
Display area and the Panel List.

Panels per Page Click One to print one panel per printed page. One panel is printed per 
page for each of the panels selected. There is no maximum number of 
panels that can be printed using this option. An extended legend 
containing information about the waveform is displayed across the end of 
the print, including the design name, the design type, the waveform 
name, and the symbol used to represent data points on this waveform.

Click Many to print multiple panels on one page. Up to eight selected 
panels can be printed on a page. An error message is displayed if more 
than eight panels are selected using the Many option in the Print window. 
In this case you must go back and reset your print options. A legend is 
printed out for each panel containing the waveform name, the design 
analysis tag name, and the symbol used for plotting the data points.

Step X View Select this toggle if you have a waveform whose view has been altered 
due to zooming and you want to print the whole waveform. It takes the 
existing X zoom factor and steps along the X axis from the beginning to 
the end of the waveform, printing consecutive sections of the waveform. 
Each section is printed on a separate page. 

Print To Click Printer to print a hard copy. This output format depends on the 
selected print driver. A number of print options are available such as 
PostScript, Encapsulated PostScript, Generic Output, and All Files.

If you click File to send the output to a file in PostScript format, this 
command changes the printer string input field to a set of radio buttons. 
Refer to Figure 4-14 on page 4-25.

Printer Format Generates output file of specific printer’s format.

PS Postscript format output.

EPS Encapsulated Postscript output.

Printer Name Enter the network name of the printer in this text field.

Size Select the page size to print a hard copy.
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Set Zoom

Select the Window >> Set Zoom option to display the Zoom 
Selected Panels dialog window shown in Figure 4-15. This window 
lets you set the zoom factor for zooming in and out of selected areas 
on the waveform displayed in a panel. The view of the waveform is 
changed by the ranges selected. The Set Local Zoom option is 
available on the context-sensitive menu in the panel. Click using the 
right mouse button to display this menu.

Figure 4-15 Zoom Selected Panels

Orientation Click either Landscape or Portrait as the page orientation for printing.

Color • Click Color to print to a color printer.
• Click Monochrome to get a black and white print.

Table 4-17 Print Buttons

Button Description

Print Click Print to print the current file selection. If the output is to a file, a 
dialog box asks you to specify the location and file name for the output.

Cancel Click Cancel to cancel the current print operation.

Help Click Help to view on-line Help about the current dialog.

Table 4-16 Print Menu (Continued)

Option Description
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Set Pan

The Set Local Pan dialog allows you to set the values for panning 
across the waveform displayed in the panel. Panning is very similar 
to a scrolling operation and you can pan horizontally or vertically by 
an amount you specify. Entering a positive delta value for the X-Axis 
shifts the waveform to the right. Entering a negative delta value for 
the X-Axis shifts the waveform to the left. Entering a positive delta 
value for the Y-Axis shifts the waveform upward. Entering a negative 
delta value for the X-Axis shifts the waveform downward.

The Set Pan option is available on the context-sensitive menu in the 
panel. Click using the right mouse button to display this menu.

Note: Panning operations are performed independently on each 
axis. When displaying two Y-axes you can set different 
panning amounts for each axis.

Table 4-18 Zoom Selected Options

Option Description

Axis Lists the axes displayed in the Results Display window. You can have 
one X-Axis and up to two Y-axes displayed.

Minimum Contains the value of the lower limits of each axis. A pop-up menu 
containing the scale factors is associated with this field.

Maximum Enter the value of the upper limit of each axis. A pop-up menu containing 
the scale factors is associated with this field.

Table 4-19 Zoom Selected Buttons

Button Description

OK Click OK to change the view in the panel to that specified.

Apply Click Apply to change the range of the axis to that specified in the Set 
Local Zoom dialog. You must click OK or press Return to close the Set 
Local Zoom dialog.

Cancel Click Cancel to cancel the current operation.

Help Click Help to view on-line Help about the current dialog.
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Figure 4-16 Set Local Pan

Table 4-20 Set Local Pan Fields

Button Description

Axis Lists the axes displayed in the Results Display window. You can have 
one X-Axis and up to two Y-axes displayed. 

Delta Contains the value of the amount that each axis is to be shifted. A pop-up 
menu containing the scale factors is associated with this field.

Table 4-21 Set Local Pan Buttons

Button Description

OK Click OK to change the view in the panel to the view specified.

Apply Click Apply to change the range of the axis to the range specified in the 
Set Local Pan dialog. You must click OK or press Return to close the Set 
Local Pan dialog.

Cancel Click Cancel to cancel the current operation.

Help Click Help to view on-line Help about the current dialog.
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Set Grid

Use the Set Grid dialog to set vertical grid line values in the panel. 

1. Select the Set Grid option from the context-sensitive menu in the 
panel.

2. Click the right mouse button to display the menu.

Figure 4-17 Test Update Dialog 

3. To set the start point in which the grid line display, enter a value 
for GridStart.

4. To set the gap between neighboring grid lines, enter a value for 
GridSpace.

Note: Whenever you use any zooming operations, reset the 
GridStart and GridSpace values, according to the start point 
value of the x_axis.

Table 4-22 Test Update Fields

Field Description

GridStart Specifies the start point, where the first grid line displays.

GridSpace Specifies the distance between two grid lines.
4-30

AvanWaves User Interface: Tools



Measure Label Options

Use this dialog window to choose your preferred label attributes. See 
Measure Label Dialog  for descriptions of the options.

Measure Preferences

From the Results Display window, select Measure >> Measure 
Preferences to display the Set Measure Preferences window. This 
window allows you to select different measure options, as well as to 
select Snap mode when measuring using one or two points. See 
Figure 5-1 for a full description.

The Select Preference Window

From the Results Display window main menu, select Tools >> 
Preferences to display the Select Preferences window. This 
window contains a set of menu options that provide general 
information on the AvanWaves application. Select options on the 
menus or click on the lists in the dialog box to set the preferences 
information.

Table 4-23 Test Update Buttons

Button Description

OK Click OK to change the view in the panel to the view specified.

Apply Click Apply to change the displayed grid lines to the range specified in the 
Set Grid dialog. You must click OK or press Return to close the Set Grid 
dialog.

Cancel Click Cancel to cancel the current operation.

Help Click Help to view on-line Help about the current dialog.
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Figure 4-18 Select Preferences Window

The menu options available in the Select Preference window are.

Table 4-24 Select Preferences Menu Options

Option Description

File >> Close Window closes the Select Preferences window

Edit >> Selected (not implemented in this release) 

Edit >> Application >> 
About

displays the About box for the AvanWaves application, giving 
version and copyright information

Edit >> Application >> 
General

displays a dialog box for setting general application preferences 
for font, foreground, and background colors

Edit >> Analysis >> Curves allows you to set color preferences and continuity for displaying 
waveforms, the symbol type, and frequency for displaying data 
points on waveforms
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Set General Preferences Dialog

From the Select Preferences window, click on Application >> 
General to show the Set General Preferences dialog window.

The Set General Preferences dialog allows you to set preferences 
for foreground and background color and also select the font used 
for menu and window names and for messages.

Figure 4-19 Set General Preferences Dialog

Table 4-25 Set General Preferences Buttons

Button Description

Set Foreground Opens the Color Preference Chooser to set the foreground color.

Set Background Opens the Color Preference Chooser to set the background color.

Set Font Opens the Font Preference Chooser to select a font to use in AvanWaves.

OK Click OK to apply the selections that you made.

Defaults Click Defaults to use the default settings for each item in the window.

Cancel Click Cancel to cancel the current operation and make no changes.

Help Click Help to view on-line Help about the current dialog.
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Set Analysis Preferences Window

From the Select Preferences window, click on Analysis >>Curves 
to show the Set Analysis Preferences dialog window.

The Set Analysis Preferences window is used to select the 
following waveform display attributes:

• The color of the displayed waveform

• Whether the continuity option is to be displayed

• Line style that represents the displayed waveform

• Symbol that represents the displayed data points on a waveform

• Frequency with which the symbols are placed on a waveform

Figure 4-20 Set Analysis Preferences Window
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Curve

The Curve number indicates the order in which the colors are used 
to display the waveforms in a panel. Eight colors are allowed, and a 
cycle is made on the eight colors.

Color

Eight colors are used to display waveforms in the panels in the 
Results Display window. The waveforms in each panel are 
considered separately. 

The colors are organized in a hierarchy, the color corresponding to 
Curve 1 being used for the first curve displayed, and the color 
corresponding to Curve 8 being that used for the last curve 
displayed. If there are more than eight curves, the first color is used 
again. A default set of colors is available initially. You can change the 
colors in the set and the order in which they are used.

Click on a color button to show the Color Preference Chooser and 
select your color choice.

Continuity

Continuity is a toggle button that you can select to display 
connections between the data points of a waveform. The full 
waveform and the symbols representing the set of selected data 
points for the analysis are displayed in the panel. Setting continuity 
off displays only the symbols representing the data points and no 
connections. The default value is on. A single click toggles the 
feature on or off.
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Line Style

The line style used to represent each curve is displayed in each 
panel. Default line style are automatically assigned to the basic set 
of eight curves.

Click on a Line Style button to show the Line Style Chooser and 
select from any one of the eight line styles.

To distinguish between different waveforms on monochrome 
hardcopy plots, you can use a different line style for each waveform.

Symbol

The symbol used to represent the data points on each curve is 
selected with this function. Default symbols are automatically 
assigned to the basic set of eight curves. 

Click on a Symbol button to show the Symbol Chooser and select 
from any one of nine symbols.

To distinguish different waveforms on monochrome hardcopy plots, 
you can use a different symbol for each waveform. 

Frequency

The Frequency setting determines how many of the available data 
points are displayed on a waveform. A frequency of two displays 
every other data point with a symbol. A frequency setting of 0 means 
that only the first data point on the curve is displayed.

Type a new number in the Frequency field to make a change.

Setting your Preference

Use the following buttons in the Set Analysis Preferences window 
to register your choices.
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Symbol Chooser

The Symbol Chooser displays a list of nine symbols that can be 
used to represent the data points on your waveform. The name of the 
selected curve is displayed in the title of this window.

Figure 4-21 Symbol Chooser

Table 4-26 Symbol Chooser Buttons

Button Description

OK Click OK to change the current symbol to the newly selected symbol.

Cancel Click Cancel to cancel the current operation.

Help Click Help to display the AvanWaves on-line Help for this window.
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Line Style Chooser

The Line Style Chooser displays a list of eight line styles that can 
be used to represent the waveform. The name of the selected curve 
is displayed in the title of this window.

Figure 4-22 Line Style Chooser

Table 4-27 Line Style Chooser Buttons

Button Description

OK Click OK to change the current symbol to the newly selected symbol.

Cancel Click Cancel to cancel the current operation.

Help Click Help to display the AvanWaves on-line Help for this window.
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Keyboard Shortcuts and Hotkeys
Keyboard shortcuts and hotkeys are used to accelerate specific 
operations that are normally invoked using a series of menu 
selections. Table 4-28 below lists the keyboard keys that are bound 
to particular functions in AvanWaves.

Table 4-28 Hotkey Definitions  

Subject Keystrokes Function
Design Ctrl + o Open Design

Ctrl + c Close Design
Ctrl + 6 Select current design 

Panels Ctrl + a Add Panel
Ctrl 1 Hide Panel
Ctrl + Del Delete Panel
Del Delete selected curve in selected panel
Ctrl u Update
Ctrl l Add Label
Ctrl 2 Delete Label

Window Ctrl + f Full Zoom (display complete data set)
Ctrl + x Zoom In X
Ctrl + 3 Zoom Out X
Ctrl + y Zoom In Y 
Ctrl + 4 Zoom Out Y
Ctrl + z Zoom In X/Y
Ctrl + 5 Zoom Out X/Y
Ctrl + t Last Zoom
Ctrl + s Set Zoom
Ctrl + Shift X Pan X
Ctrl + Shift Y Pan Y
Ctrl + Shift Z Pan X/Y
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Measure Ctrl + 8 Measure Point
Ctrl + m Measure Point to Point
Ctrl + 9 Delete Measure
Ctrl + d Delete All Measures
Ctrl + g Measure Label Options
Ctrl + i Measure Preferences

Configuration Ctrl + n Open configuration
Ctrl + v Save configuration

Tools Ctrl + b Display Results Browser 
Ctrl + e Display Expression Builder dialog
Ctrl + p Display the Print dialog
Ctrl + Shift + u Display Preference Manager dialog
Ctrl + h Run HSPICE – displays the Run Manager dialog

Table 4-28 Hotkey Definitions (Continued) 

Subject Keystrokes Function
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5
Viewing Waveforms 5

This chapter describes the functions available in AvanWaves to 
change the view of the current waveforms displayed in panels. Views 
of waveforms are changed by selecting zooming and panning 
operations from the Windows menu.
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Changing Views in a Panel
Use the Window menu for global operations. You can apply these 
operations to several selected panels at a time. Window menu 
options change the view of the waveform displayed in the panel.

Full

Full displays the complete waveform in the waveform display area.

Zoom In X

Select Zoom In X to magnify the area selected on the waveform. 
The panel view changes to the selected view. You can make 
selections only in relation to the X-axis. This is horizontal zooming. 

To zoom into a specific area of the waveform:

1. In the Results Display window, select Window >> Zoom In X.

This displays a “magnifying glass” cursor inside the waveform 
display area in the Panel. This type of cursor is used to specify 
the direction (left or right) and the distance on the X-axis that you 
want to select for zooming in the waveform display. 

2. Position the cursor at the start of the area you want to select. 
Then, holding the left mouse button down, drag the cursor over 
the distance you want to select for zooming. Release the button 
when you have selected the area. 

The line defines the waveform area to present in more detail. The 
previous panel view changes to the selected view.
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Zoom Out X

Select Zoom Out X to reduce the results window scale horizontally. 
To zoom out in a waveform display:

1. In the Results Display window, select Window >> Zoom Out X.

This action displays a “magnifying glass” cursor inside the 
waveform display area of the panel. This cursor is used to specify 
the X-axis start coordinate and the amount of zoom-out required 
for the resultant display.

2. Position the cursor at the point you want to be the start of the 
zoomed-out display and, depress the left mouse button. Then 
generate a line by dragging the cursor from left to right over the 
section of display that you want to include in the result. Release 
this button to generate the new view. 

You can draw the line from right to left but the left-hand end of this 
line still becomes the start point for the resultant display.

3. AvanWaves zooms out the display to a new X-axis scale length 
equal to the ratio of X-axis scale length to the length of the line 
dragged by the mouse. 

Zoom In Y

Select Zoom In Y to zoom into the area selected on the waveform. 
The panel view then changes to that of the selected view. You can 
make selections only in relation to the Y-axis. This is vertical 
zooming. 

To zoom into a specific area of the waveform along the Y-axis:

1. In the Results Display window, select Window >> Zoom In Y.

This displays a magnifying glass cursor inside the waveform 
display area in the Panel. This type of cursor is used to specify 
the direction (up or down) and the distance on the Y-axis that you 
want to select for zooming in the waveform display. 
5-3

Viewing Waveforms: Changing Views in a Panel



2. Position the cursor at the start of the area you want to select. 
Then, holding the left mouse button down, drag the cursor over 
the distance you want to select for zooming. Release the button 
when you have selected the area. 

The line defines the area of the waveform that you want 
presented in more detail. The previous panel view changes to the 
selected view.

Zoom Out Y

Select Zoom Out Y to display the results window to a reduced scale. 
This command provides only vertical zooming. 

To zoom out in a waveform display:

1. In the Results Display window, select Window >> Zoom Out Y. 

This action displays a “magnifying glass” cursor inside the 
waveform display area of the panel. This cursor is used to specify 
the Y-axis start coordinate and the amount of zoom-out required 
for the resultant display.

2. Position the cursor where you want to start the zoomed-out 
display. Press the left mouse button, generate a line by dragging 
the cursor from bottom to top over the section of display that you 
want to include in the result. Release this button to generate the 
new view. You can draw the line from top to bottom but the bottom 
end of this line becomes the start point for the resultant display.

AvanWaves zooms out the display to a new Y-axis scale length 
equal to the ratio of Y-axis scale length to the length of the line 
dragged by the mouse. 
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Zoom In X/Y

Select Zoom In X/Y to zoom into the area selected. You can select in 
both directions. The panel view then changes to that of the selected 
view. 

To zoom into a specific area of the waveform in relation to both the X-
axis and the Y-axis:

1. In the Results Display window, select Window >> Zoom in X/Y.

This displays a magnifying glass cursor inside the waveform 
display area in the Panel. This type of cursor is used to specify the 
distance in the X and Y directions that you want to select for 
zooming in the waveform display. 

2. Position the cursor at the start of the area you want to select. 
Then, holding the left mouse button down, drag the cursor over the 
distance you want to select for zooming. Release the button when 
you have selected the area. 

The line defines the area of the waveform that you want to zoom 
into. The previous panel view then changes to the selected view.

Zoom Out X/Y

Select Zoom Out X/Y to display the results window to a reduced area 
scale. This command zooms an area (horizontal and vertical).

To zoom out in a waveform display:

1. In the Results Display window, select Window >> Zoom Out X/Y.

This action displays a “magnifying glass” cursor inside the 
waveform display area of the panel. This cursor is used to specify 
the X-axis and Y-axis start coordinates and the amount of zoom-
out required for the resultant display.
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2. Position the cursor where you want to start the zoomed-out 
display. Press the left mouse button, generate a rectangle by 
dragging the cursor from left to right and bottom to top over the 
section of display that you want to include in the result. Release 
this button to generate the new view. You can draw the rectangle 
in the opposite direction but the bottom left-hand end of the 
rectangle still becomes the start point for the resultant display.

AvanWaves zooms out the display to new X-axis and Y-axis scale 
lengths equal to the ratios of X-axis and Y-axis scale lengths to the 
lengths of the rectangle sides that the mouse drags. 

Last Zoom

Selecting Last Zoom returns to the previous zoom selection. When 
you select Last Zoom, the panel view changes to display the 
previously selected zoom area.

Pan X

Selecting Pan X displays a cross-shaped cursor inside the waveform 
display area. This type of cursor is used to specify the direction (right 
or left) and the distance on the X-axis that you want to move the 
waveform in the waveform display. 

To pan in the X direction, select the direction and the distance that you 
want to move the waveform by dragging the cursor a specified 
amount to the right or left, while holding the left mouse button down. 
The waveform is shifted parallel to the X-axis.

Pan Y

Pan Y displays a cross-shaped cursor in the waveform display area. 
This cursor specifies the direction (up or down) and the distance on 
the Y-axis to move the waveform in the waveform display. 
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To pan in the Y direction, select the direction and the distance that 
you want to move the waveform by dragging the cursor a specified 
amount up or down, while holding the left mouse button down. The 
waveform is shifted parallel to the Y-axis.

Pan X/Y

Select Pan X/Y to display a cross-shaped cursor inside the 
waveform display area in the Panel. This type of cursor is used to 
specify the distance that you want to move the waveform in X 
direction (right or left) and the Y direction (up or down). 

To pan in the X and Y directions, hold the left mouse button, and drag 
the cursor a specified amount in any direction. The waveform view 
shifts by the distance specified in the X and Y directions.

Stacked/Overlay

When AvanWaves is in overlay mode (default), it generates one X 
and one Y-Axis and draws each curve in that area. In overlay mode, 
AvanWaves combines a single X-Axis with a separate Y-Axis for 
each signal, so the curves stack one above the other on the screen. 

Select Stacked/Overlay Mode to toggle between these two display 
formats. This functionality is also available in the pop-up menu, 
where the bottom entry is either Stacked Mode or Overlay Mode, 
depending on the mode to which you set AvanWaves.

Note: Each curve has its own Y-Axis, so you can zoom the Y axis of 
each plot in stacked mode. Switch to overlay mode to select a 
worst-case full-scale axis for all curves. Toggle back to 
stacked mode to restore the saved Y-Axis zoom factors on 
each curve.
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Performing Measurements
You can use the Measure menu in the Results Display window. It 
contains six options: 

• Point

• Point to Point

• Delete Measure

• Delete All Measures

• Measure Label

• Measure Preferences

Measure reads specific values from a waveform displayed in a 
panel. The Measure operation performed on a waveform can 
provide you with the X and Y coordinates of a point on a waveform 
displayed in the Results Display window, or the difference in the 
coordinates of two points selected on a waveform or between 
waveforms.

When you use Measure >> Point or Measure >> PointToPoint, the 
X- and Y-axis labels and the coordinates of the cursor location are 
shown in boxes on the right side of the Results window toolbar. The 
X-axis label is shown in the leftmost box, the X-axis value of the 
cursor location is shown in the next box, then the Y-axis label, and 
finally the Y-axis value of the cursor location.
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Measure

The Measure option lets you interactively measure data on your 
waveform display. You can measure data on one waveform or 
between waveforms on the same panel. This interactive measure 
returns scalar results and displays them on the screen. To measure, 
place markers on one or more waveforms.

Anchor Cursor

Selecting this entry enables you to place a set of anchored cursors 
or adjustable measures on the display. One cursor will be dropped 
on the next left mouse button press, and the second on the following 
release of the button. Each of the cursors will appear as a vertical 
line through all panels that share the same units on the X-Axis.

Note: Because anchored cursors appear in all compatible panels, 
they allow convenient measurements between panels. The 
only requirement is units compatibility, not value compatibility, 
thus all time axes are considered compatible.

Table 5-1 Functions in Measure Menu

Function Description

Point Displays the X and Y coordinates for the point selected on a 
waveform, and the value of the derivative at that point.

PointToPoint Displays the delta X, delta Y, and the slope values for the two 
points selected.

Both Point and PointToPoint operations turn on the X/Y 
coordinate display in the upper right corner of the Results 
Display window. 

Delete All Removes all measures from all selected panels

Delete Measure Removes the selected measure markers from the waveform 
display. To select a marker, hold down the Shift key and click with 
the left mouse button on the marker. This is a select/deselect 
toggle. To deselect a marker, perform the same operation again. 

Measure Label Options Sets the display items inside the measure label. The Measure 
Label Options dialog is displayed. 
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While being dragged and after being dropped, the first cursor 
indicates its X-Axis value at the top of the window and the value of 
every curve at the point where it crosses the cursor in a label 
positioned near that crossing. The second cursor indicates these 
values as well, but also includes a delta value that is the change in 
the value of that signal as measured from the first cursor.

After you place both cursors, to pick up either and move them again, 
left click on the curve, drag to a desired new location, then release it. 
For more-accurate relative measurements, duplicate a panel, zoom 
each panel in on a transition, and drop the anchored cursors until 
one appears in each zoomed in panel. During dragging, only values 
on the moved cursor update. Deltas update after you drop the cursor. 

Only one pair of anchored cursors can be on the display at a time. 
Selecting this entry a second time removes the first pair and initiates 
placement of a replacement pair.

• Use Remove Anchors to remove the anchored cursors from the 
display.

• Use Measure Preferences (Figure 5-1) to select different 
measure options, and to select Snap mode when measuring 
using one or two points.
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Figure 5-1 Measure Preferences Window

These preferences apply to all selected panels.

Table 5-2 Panel Preference Settings

Preference Setting Description

Set Snap All Values Snap to interpolated points during measurement.

Set Snap Data Point Snap to simulation points during measurement.

Set Lock All Angle No limitation during measurement.

Set Lock Vertical At first point Limit measurement to the X (horizontal) direction only.

Set Lock Horizontal At first point Limit measurement to the Y (vertical) direction only.

Set Lock Vertical at X Value Limit the measurement only on X direction, and lock to the 
value specified in the string input field.

Set Lock Horizontal at Y Value Limit the measurement only on Y direction, and lock to the 
value specified in the string input field.

Precision Precision in the measure label and X-Y coordinate display 
boxes, at the upper right of the Results Display window.
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Measure Label Dialog

Use the Measure Label Options dialog (Figure 5-2) to set the 
display item and features for the selected measure labels. All 
subsequent measures use the new settings specified in this dialog.

Table 5-3 Measure Label Options

Option Description

Title Title string for the measure label.

X1 Title for the X1 value.

Y1 Title for the Y1 value.

Current X Title for the current X value (with label).

Current Y Title for the current Y value (with label).

Delta X String in front of the Delta X value, for two point measurement.

Delta Y String in front of the Delta Y value, for two point measurement.

Slope String in front of the Slope value, for two point measurement.

Derivative String in front of the Derivative value.

Orientation Orientation of the measure label relative to the measurement 
point: NW - ?, NL- ?, SL-?, SW-?. 

Transparency Background of the measure label: transparent or opaque.
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Figure 5-2 Measure Label Options Dialog
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6
Creating Macros and Expressions 6

This chapter describes the procedures for building expressions and 
macros with the Expression Builder in AvanWaves. To analyze 
simulation data from HSPICE, you can display available raw output 
data in AvanWaves. However, more complex analyses can be 
performed by combining the simulation data in mathematical 
expressions that include

• Predefined functions 

• Operators 

• Other expressions 

• Macros

How these components are combined to create expressions for 
analysis of simulation data is described in the following sections. 
6-1



Expression Builder

The Expression Builder in Figure 6-1 creates expressions to 
perform detailed analysis of simulation data. Results Display 
window can display the waveforms that the expressions produce.

Figure 6-1 Expression Builder Window

Note: When bringing arguments into expressions, if they contain 
sweep data, the expression is calculated for each of the 
sweeps. However, the Expression Builder cannot deal with 
expressions that have different numbers of sweeps for each of 
its arguments – for example, five sweeps in arg1 and ten 
sweeps in arg2. The number of sweeps must be the same for 
all arguments in the expression.

Expressions can be created by typing the expression directly into the 
expression field, or they can be created by making selections in the 
desired order from the lists of available functions, waveforms, 
operators, macros, and other expressions. 
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Functions

The Functions list shows the functions that are available for use in 
creating expressions and macros. These are predefined functions. 
The functions available in AvanWaves are defined in Appendix B.

To use a function in an expression:

1. Select the function from the Functions list, then drag it into the 
Expression field. Alternatively, double-click on the function to 
insert it into the Expression field at the current cursor location. 
You can place the cursor by clicking at the desired insertion 
location.

2. Enter the arguments for the function either manually or by 
selecting and dragging curves from the Results Browser.

If a function takes two arguments, you can select both values for 
these arguments from the Results Browser and drag them to the 
Expression field together. Each curve entered as an argument is 
prefixed with its design and analysis number.

All functions work on either constants or waveforms. If a function is 
applied with one argument that is a constant and one argument that 
is a waveform, the constant is changed into a “constant value” 
waveform, and then the operation is performed.

Functions and Expressions can contain arguments that have not 
yet been defined. A function must have at least one argument, and 
not more than two. The expression name must be unique.
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Operators

A set of arithmetic, numeric comparison, Boolean, and conditional 
operators are available for use in building expressions and macros 
in the Expression Builder. The following are the types of operators 
that you can select from the Operators list:

• Arithmetic (+, -, *, /) — return analog waveforms only

• Comparison (>, <, <=, >=, !=, ==) — return logical waveform 
results (1 or 0)

• Boolean combination (&&, ||, !) — return logical waveform results 
(1 or 0)

• Conditional (expr1 ? expr2 : exp3) — analog wave built from 
expr2 if expr1=0 or expr3 if expr1 is not equal to 0

To use an operator in an expression:

1. Place the cursor in the expression where you want to enter the 
operator. 

2. Select the operator from the Operators list. 

3. Click on the operator and drag it into the Expression field.

Alternatively, double-click on an operator to insert it into the 
Expression field at the current cursor location.

Using Curves in Expressions

Any curve (simulation waveform) can be placed in an algebraic 
expression as a parameter. The result of the expression operating on 
the waveform then can be displayed as a new waveform.
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To use a waveform as a parameter in an expression:

1. Select the function to use.

In the Expression Builder window, double-click on the function 
you want to use in the expression. The function is displayed in the 
Expression field of the Expression Builder window.

2. Select the waveform.

In the Results Browser, select the waveform you want to use. 
Holding the mouse button down, drag the waveform into the 
Expression field of the Expression Builder window. This places 
the waveform inside the function, so that it can be used as an 
argument.

Note: A function can have many parameters or arguments. You can 
select waveforms to be used as parameters in a function one 
at a time, or make multiple selections. When you insert 
multiple waveforms in the Expression field, they fill up the 
parameter values in the order in which you select them.

Selecting and Editing Expressions

To select an existing expression:

1. Click Clear. This clears the Expressions field.

2. With the left mouse button, double-click on the expression (result 
name) in the Expressions list.

The actual expression is displayed in the Expression field, and 
the name of the expression is displayed in the Result field.
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To edit the definition of an expression:

1. Select the expression.

2. In the Expression field, modify the expression definition, then 
click Apply.

The expression is modified to reflect the changes.

Another way of modifying an expression is by changing the 
macro definition within the expression. For more information on 
Macros, see Editing a Macro .

Using Expressions

The Expressions list contains all the expressions created in 
AvanWaves using the Expression Builder. The expressions are 
saved with the current designs when a configuration is created. An 
expression can be used as part of another expression by selecting it 
and dragging it into the Expression field. 

To add an expression to the Expressions list:

1. Enter an expression in the Expression text entry field, and enter 
a name for the result in the Result field. 

2. Click Apply or press Return to enter the expression in the 
Expressions list. 

The expression is entered in the list under the Result name. 

To expand an expression to display its definition, double-click on the 
result name in the Expressions list. 

The expression name is entered into the Result field and the 
expression definition is displayed in the Expression field.
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To display an expression:

1. Select the expression name in the Expression list and drag it 
into the waveform display area of the panel. 

The result of the expression is displayed as a waveform, and the 
name of the expression, preceded by the design and analysis 
number, is added to the Wave List in the Results Display 
window.

You cannot display an expression whose result is simply a 
constant, for example, abc = abs(-20). You can use it in another 
expression, but cannot display a constant result such as ‘abc’ by 
itself. It must have a signal associated with it.

2. To view the waveforms associated with the expression, double-
click on the name of the expression in the Wave List. 

Note: Sweeps that are derived from an expression are not expanded 
in the Wave List, but they are expanded when they come from 
the simulator.

Deleting Expressions

To delete an expression from the Expression list, do either of the 
following:

• Using the left mouse button, select the expression from the list, 
then click Delete.

• Select the expression, then select Options >> Delete 
Expression.
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Macro Builder

Macros are user-defined expressions in a C-like language. The 
Macros list shows all of the macros created or loaded into 
AvanWaves. You can select macros from this list, and use them in 
expressions in the same way that you use functions in expressions. 
Table 6-1 summarizes the components of a macro.

The head of a macro contains the macro name, followed by a 
parenthesized list of parameters separated by commas. For 
example the head of a magnitude function can be:

mag(x,y)

The body is the definition of the macro, which uses the parameters 
specified in the head. For example, the body of a square root 
function can be: 

sqrt(x*x + y*y) 

To use a macro in an expression:

1. Place the cursor in the expression where you want to enter the 
macro. 

2. Select the macro using the left mouse button. 

3. Click on the macro with the middle mouse button, and drag and 
drop it into the expression field. 

Table 6-1 Components of an AvanWaves Macro

Component Description

Macro Head Name of the macro and the names of its arguments.

Macro Body Any combination of functions and operators available in the 
Functions and Operators lists in the Expression Builder window

Notes Notes about the macro.
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Alternatively, you can select the macro and double-click on it with 
the left mouse button.

Creating and Using Macros 

To create a macro:

1. Select Options >> Add Macro in the Expression Builder.

This displays the Add Macro dialog box, as shown in Figure 6-2.

2. Enter the name of the macro and the arguments associated with 
the macro into the Macro Head field.

3. Enter the macro definition into the Macro Body field. The macro 
definition can contain functions and operators defined previously 
in the Expression Builder window.

4. Click Apply to add the macro to the Macros list.

Figure 6-2 Add/Edit Macro Dialog
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To use a function or operator in a macro definition:

1. Place the cursor at the point in the macro where you want to enter 
the function or operator.

2. Select the function or operator with the left mouse button.

3. Click on the function or operator with the middle mouse button, 
and drag and drop it into the macro body.

To use an operator in a macro definition:

1. Place the cursor at the point in the macro where you want to enter 
the operator.

2. Select the operator with the left mouse button.

3. Click on the operator with the middle mouse button, and drag and 
drop it into the macro body.

Displaying a Macro

To display a macro that has previously been defined:

1. Select the macro from the Macros list.

2. Select Options >> Edit Macro.

The Macro head, definition, and any notes on the macro in the 
Edit Macro dialog are displayed.

Editing a Macro 

To edit a macro:

1. Click on the macro you want to edit in the Macros list. 

2. Select Options >> Edit Macro. 

This displays the Edit Macro dialog box containing the macro 
you selected.
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3. Enter your changes to the macro head, body, or notes sections. 

4. Click OK to apply the changes you made.

The updated Macro is added back to the Macros list.

To update an expression after editing a macro:

1. In the Expression Builder, select each expression that uses the 
macro.

2. Click Apply.

This updates the expressions to use the new macro definition.

Loading a Macro 

The Load Macros function is used to load previously-saved macros 
into the Macros list. You define the macros, and you can use them in 
building expressions.

Note: The Load Macros dialog by default lists the available macro 
files with names of the form *.mac. Use the Filter command to 
display other types of files. 
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Figure 6-3 Load/Save Macro Dialog

To load a macro:

1. Select the directory location of the macro and select the name of 
the saved macro file. 

2. Click OK or Apply to load the selected macro file and add it to 
the Macros list in the Expression Builder window. 

Saving a Macro 

The Save Macro window allows you to save macros created during 
the current session to a file. This allows you to load and use them in 
another AvanWaves session with other designs.

To save a macro:

1. In the Save Macro dialog, select the directory and the name of 
the file in which to save the macro.
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2. Click OK or Apply to save the macro definition to the selected 
file.

Deleting a Macro

To delete a macro, choose one from the Macros list and select:

Options >> Delete Macro
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7
Using Configurations 7

A configuration in AvanWaves is a snapshot of the AvanWaves 
environment. You can create and save a configuration, or a set of 
configurations, for any design. You can open a saved configuration 
later in the same AvanWaves session or in future AvanWaves 
sessions.

The following information is saved in a configuration file:

• status of all tools, windows, measurements, and notes

• all panels and waveform displays 

• expressions and macros

• interactive measurement data

• labels
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Configuration Files
Configurations are stored in configuration files with names of the 
form <config_name>.cfg in the directory <design>.sav in your design 
directory. Use the Configuration >> Save command to name the file 
in which to save the configuration. You can use the 
Configuration >> Open command to load the configuration back 
into AvanWaves.

You must open a design (with the Design >> Open command) 
before you can use any of the Configuration menu commands.

Saving a Configuration
To save a configuration, select the Configuration >> Save 
command in the Results Display window. 

The Save Configuration dialog appears. The complete path to the 
current design is shown in the Design field. The Save 
Configuration dialog allows you to save the configurations during a 
AvanWaves session. This is helpful for documenting your circuit 
simulation, or for restoring a configuration in a later AvanWaves 
session. Only data derived during your present session is stored.

Figure 7-1 Save Configuration Dialog
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1. In the Config field, enter the name of the file in which you want 
to save the current configuration.

2. Click Save to save the configuration.

If a configuration file with the same name already exists in the 
<design>.sav directory, you will be asked to confirm that you 
want to overwrite it. 

3. Click OK to overwrite the configuration, or Cancel to cancel the 
current operation. 

Opening a Configuration
To open a saved configuration, select the Configuration >> Open 
command in the Results Display window. 

The Open Configuration dialog opens. 

Figure 7-2 Open Configuration Dialog

The Design field shows the complete path to the current design. The 
Config field shows the name of the first configuration that you 
opened for the current design. Before opening a new configuration, 
you are prompted to save the state of your current design.

To see a list of all configurations for the current design:

1. Click the left mouse button on the arrow in the Config field.

The pull-down menu displays. 
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2. Select a configuration from the menu, then click Open.

The new configuration opens. 

Opening a configuration removes all of the information on the screen 
about the current design and replaces it with the design information 
associated with the selected configuration. The state of the panels 
and the tools is set to the state of the configuration just opened.

If the configuration you opened belongs to the current design, but 
also contains waveforms from another design, the associated design 
is opened and displayed. Another window also is opened, listing the 
waveforms that were not retrieved in opening the configuration, 
giving the design name, and giving you the option to open the 
design. To open the design, click Apply in this window. The design 
is then opened and the panels updated with the waveforms. 

Note: You can see only the configurations associated with the 
current design.

Deleting a Configuration
To delete a configuration:

1. Select the Configuration >> Delete command in the Results 
Display window. 

This displays the Delete Configuration dialog box. The path to 
the currently open design is listed in the Design field.

2. To select the configuration you want to delete, click on the pull-
down arrow in the Config field. 

3. Select the configuration to delete.

4. Click on Delete.
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8
Setting Preferences 8

This chapter describes how to customize your environment and 
setting personal preferences in MetaWaves. You can set:

• General application preferences

• Preferences for displaying and analyzing waveforms, such as 
waveform color and symbol type
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Select Preferences Window
Open the Select Preferences window by selecting Tools >> 
Preferences in the Results Display window. The Select 
Preferences window contains a set of menu options (see Table 8-1) 
that provide general information on the MetaWaves application. (See 
Figure 8-1.) Select options on the menu or click on the lists in the 
dialog box to set your general application preferences.

Figure 8-1 Select Preferences Window

Table 8-1 Select Preferences Menu Options

Option Description

File >> Close Window Closes the Select Preferences window.

Edit >> Selected Not available in this release.

Edit >> Application >> About Displays the About box for the MetaWaves application, 
including version and copyright information.

Edit >> Application >> General Displays a dialog box for setting general application 
preferences for font, foreground, and background colors.

Edit >> Analysis >> Curves Sets color preferences and continuity for displaying 
waveforms, the symbol type, and selects frequency for 
displaying data points on waveforms.
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Setting Analysis Preferences

The Set Analysis Preferences window is used to select the 
following waveform attributes:

• Color of the displayed waveform

• Whether the continuity symbol is displayed 

• Symbol that represents the displayed data points on a waveform

• The frequency with which the symbols are placed on a waveform

This dialog sets the defaults for the eight curve preferences inherited 
in each panel. The preferences for each curve are set individually. 

To bring up the Set Analysis Preferences window, in the Select 
Preferences window select Edit >> Analysis >> Curves.

Setting Waveform Color

You can use a default set of colors to initially display curves. You can 
change the colors in the set, and the order in which you use them.

To customize the color of a waveform:

1. Click in the color box associated with a particular curve. 

The Color Preference Chooser is displayed. 

2. In the circular color palette, select the color in which you want to 
display the curve.

The selected color is displayed in a view box beside the palette. 
Three color control boxes (Light, Hue, and Saturation) are 
displayed below the palette. 

3. Click inside these boxes to select the amounts of light, hue, and 
saturation that you want to make up the new color.

The arrows move to indicate your new Color, Hue, and 
Saturation selections.
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4. Repeat these steps for each curve for which you want to change 
the display color.

5. To apply the color to the currently selected curve, click OK. 

6. The dialog box disappears and the color box in the Set Analysis 
Preferences window updates.

Setting Continuity Display

Select Continuity to display connections between data points in a 
waveform. Set Continuity off to display only symbols representing 
the data points, with no curve segments connecting the symbols. 
The default value is on. A single click toggles the feature on or off.

Setting Line Style

You can assign different line styles to each curve to differentiate 
waveforms on monochrome hardcopy plots. Default line styles are 
automatically assigned to the basic set of eight curves.

To change the line style assigned to a curve:

1. Click on the line style that you want to change. 

The appropriate Line Style Chooser opens for the particular 
curve associated with that line style.

2. Select a line style from one of the eight line styles available for 
each curve.

3. Click Apply.

Setting Symbol Type

You can assign different symbols to each curve to differentiate 
waveforms on monochrome hardcopy plots. To select the symbols 
that represent the data points on a curve, use the Symbol function. 
You can use only one symbol per curve. Default symbols are 
automatically assigned to the basic set of eight curves. 
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To change the symbol assigned to a curve:

1. Click on the symbol to change. The appropriate Symbol 
Chooser opens for the particular curve associated with that 
symbol. 

2. Select one of the nine symbols available for each curve.

3. Click Apply.

Setting Symbol Frequency

The Frequency setting determines how many of the available data 
points on a waveform are marked with the designated symbol. For 
example, a symbol frequency of 2 displays the symbol for alternate 
data point. A frequency of 0 means that only the first data point on 
the curve is marked with the symbol. Click OK to apply the 
preference selections.

Setting General Preferences

The Set General Preferences dialog lets you set preferences for 
foreground and background colors and to set the font used for menu 
and window names and for displaying messages.

To open the Set General Preferences window, in the Select 
Preferences window select Edit >> Application >> General.

Setting Font

The Font Preference Chooser allows you to customize the font 
used in the MetaWaves application. 
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To customize the font: 

1. Click Set Font to open the Font Preference Chooser. 

2. In the Family box, select the font you want to use.

The selected font is displayed in a view box at the top of the Font 
Preference Chooser dialog box.

3. In the Face box, select the typeface that you want to use.

4. In the Size box, select the font size

The fonts available depend on your current windowing system.

5. Click OK.

Setting Background and Foreground Colors 

Use the Color Preference Chooser to customize the foreground 
and background colors for your application.

To set background or foreground colors in the MetaWaves interface:

1. To open the Color Preference Chooser, click Set Background 
or Set Foreground. 

2. In the circular color palette, select the color you want by clicking 
on that colored area.

The selected color is displayed in a view box beside the palette. 
Three color control boxes (Light, Hue, and Saturation) are 
displayed below the palette. 

3. To select the amounts of light, hue, and saturation that you want 
to make up a particular color, click inside these boxes. 

The arrows move to indicate your Color, Hue, and Saturation 
selections.

4. To apply the color to the foreground or background, click OK. 

The dialog box disappears and the colors are updated.
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9
Run Manager 9

The AvanWaves Run Manager provides a way to start and stop 
HSPICE, edit the source files, and view the listing files for all of the 
open designs within the session. The status of the simulation run 
also is echoed to the screen for reference.
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Invoking the Run Manager
To invoke the Run Manager from AvanWaves, select

Tools >> Run HSPICE

This command opens the Run Manager dialog box, listing all open 
designs in the Designs listbox and the Status of each, as shown in 
Figure 9-1. Table 9-1 describes the features of the Run Manager 
dialog box.

Note: Although this section uses HSPICE as an example, you can 
easily substitute it with Star-SimXT by changing the value in 
the Default Simulator field under the Preferences button.

Figure 9-1 Run Manager Dialog
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Table 9-1 Features of the Run Manager Dialog

Feature Description

Status Lists the present status of each HSPICE job. 

Design Lists all open designs. You can run a design, edit a source file, and 
view a listing in simultaneous windows.

Run Displays the server chooser dialog for you to run HSPICE.

Stop Stops the HSPICE run.

Source Displays a window with the editor of your choice to edit the HSPICE 
source file (.sp file). 

Listing Displays a window with the editor of your choice to view the HSPICE 
listing file (.lis file). 

Preferences Displays the Run Manager Preferences dialog, allowing you to 
select the type of text editor, simulator, and terminal to use.
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Running HSPICE
To run HSPICE from the Run Manager: 

1. Select a design to run from the Designs listbox. 

2. Click on the Run button. 

HSPICE is run on the design that you just selected.

3. Select Panel >> Update to update the waveform display with the 
new simulation data.

Editing the HSPICE Source File
To edit the HSPICE input file (.sp file), click on the Source button in 
the Run Manager dialog, displayed in Figure 9-2. The source code 
is shown in the window with the selected text editor.

Figure 9-2 HSPICE Source in VI Editor Window
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Viewing the Listing File

After a simulation is completed, you can view the listing file (.lis) by 
clicking the Listing button in the Run Manager dialog. The listing file 
is shown in the window with the editor of your choice, as shown in 
Figure 9-3.

Figure 9-3 HSPICE Listing File in VI Editor Window
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Run Manager Preferences

You can customize the HSPICE run environment, such as setting the 
default simulator, the editor command, and the X-term command for 
Run Manager. To open the preference dialog (see Figure 9-4), click 
on the Preferences button in the Run Manager dialog. Table 9-2 
summarizes the fields in the Run Manager Preferences dialog.

Figure 9-4 Run Manager Preferences Dialog

Table 9-2 Run Manager Preferences Fields

Field Description

Default simulator Usually HSPICE. Star-SimXT is an alternative.

Editor command Common options are vi or emacs. If your editor displays it own 
window, leave no entry in the XTERM command field.

XTERM command Enter xterm in this field.

Machine Enter the machine identification in this field. 

Version Enter the path to the install directory for the simulator that you 
want to run.
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MS Windows Launcher 10

This chapter describes how to set up and use the MS Windows 
Launcher.
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Figure 10-1 shows the directory structure for the MS Windows 
Launcher.

Figure 10-1 Directory Structure

Setting Up Required Files

The Launcher requires two files for successful operation:

%AVANHOME%\versions.txt
%AVANHOME%\hspui.cfg

The first of these files tells the Launcher what versions of HSPICE/
Win are available for simulation and waveform analysis. The default 
file contents are:

<your AVANHOME> HSPICE/Win 2001.2

For example:

C:\AVANTI\97 HSPICE/Win 2001.2

The second of these files configures the Launcher with information 
from the last run.

Design dir

Sim. output
.lis

Measures
.mt#,.ma#,.ms#

Raw output
.tr#,.ac#,.sw#

Sim. input
*.sp

Design Config
*.cfg
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Working with Designs
A new design can be created in several ways. The Launcher allows 
you to browse for an input file for HSPICE, which has the default file 
suffix .sp. The Launcher Browse button opens a standard file 
browser.

Selecting a file of the type <design>.sp causes the Launcher to 
display the main form, which contains the following items:

• Input filename

• Design title (the first line of the file <design>.sp)

• Output filename

• HSPICE and AvanWaves version

New designs can be saved with the command File >> Save.

The commands File >> New, Open, and Close prompt the user to 
save the current design if changes have occurred.

Table 10-1 Design Commands in the Launcher

Command Description

File >> New Clears the Launcher and opens a new design

File >> Open Opens an existing design with the file browser

File >> Save Saves the current design information

File >> Save As Not implemented in Version 1.0

File >> Close Closes the current design

<LastDesigns> Lists the last five designs opened

File >> Exit Exits the Launcher
10-3

MS Windows Launcher: Working with Designs



The Launcher checks on the status of a given design when it is 
opened. If the input file exists, the Simulate button is active. If the 
listing file exists for the design, the Edit Listing button is active. The 
Edit Netlist and AvanWaves buttons are always active.

You do not need to save a design to Simulate or view the results of 
a simulation with AvanWaves.

Figure 10-2 shows the main window of the Launcher.

Figure 10-2 Launcher Main Window

Configuring the MS Windows Launcher

Customize configurations using the Configuration menu of the 
Launcher as shown in Figure 10-3.

The start-up directory defaults to the value of the AVANHOME 
environment variable set up during HSPICE installation.

• The input file suffix defaults to .sp.

• The output file suffix defaults to .lis.

• The editor defaults to notepad.exe.

If you change a value, the Launcher updates the <AVANHOME>/
hspui.cfg file. The next Launcher run provides the new values.
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Figure 10-3 Launcher Options Window

The Configuration >> Versions item lists current executables and 
their paths for the Launcher (HSPUI), HSPICE, and AvanWaves.

Note: Standard menu items, such as File and Edit, display on the 
HSPICE/Win menu bar, but are not available in this release. 
The Configuration >> Version strings change from the main 
window Versions combo box. You cannot change them here. 

To associate your <design>.sp file with the Launcher, use the File 
>> Associate command in the Windows File Manager. You can 
double-click on an .sp file in the File Manager window to 
automatically invoke the HSPICE/Win Launcher. Refer to your 
Windows documentation for details on how to do this.

Running Multiple Simulations
Use the HSPICE/Launcher file browser to build a list of simulations 
from different directories for consecutive HSPICE processing.

Press the Multi-Jobs button in the main window to open the 
HSPICE Multi-Job window (Figure 10-4). Simulation files are chosen 
from the Drive/Directory list box and placed in the Files list box.
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Figure 10-4 HSPICE Multi-Jobs Window

Building the Batch Job List

1. Press the Multi-Jobs button in the main window.

2. Using the Drive/Directory boxes, locate the directory of files that 
you wish to simulate.

3. To copy all files in the directory, press the Copy button on the 
right side of the Hspbat window.

Note that any file names already in the list will be replaced.

4. To add additional files from other directories, repeat Step 2 and 
use the Append button.
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Simulating the Batch Job List

1. To simulate all of the files in the Batch Job list, set the pulldown 
menu to All and press the Simulate button.

2. To run simulation on a single file or a group of files, set the 
pulldown menu to Selected and select those files you wish to 
simulate from the Batch Job list box.

Use the left mouse button to select a single file.

- Press and hold the Control key and select another file with the 
left mouse button to add to the selected list.

- Press and hold the Shift key to select all files between the 
current file and the last selected file.

3. Press the Simulate button to start the consecutive simulations.

Using the Drag and Drop Functions

The HSPICE Multi-Jobs window provides a drag and drop capability 
to remove files from the list, edit files, run simulations and view the 
results with AvanWaves. 

Beside the icons, the user also can use the Text Editor box to view 
and edit the design file (<design>.sp). To do this, drag and drop the 
file from the upper list box to the bottom one. The file contents are 
displayed in the bottom editor for the user to view and/or edit.

To display files associated with a design, double click on the upper 
list box on the selected design file (<design>.sp file). All associated 
files (tr#, ac#, sw#, mt# ...) are listed in the bottom list box.
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11
Running the Tutorial 11

The examples within this chapter describe how you can use 
AvanWaves to evaluate the results of various types of HSPICE 
simulations. This chapter contains examples for three kinds of 
analysis:

• AC

• Transient

• Fast Fourier Transform (FFT) 
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The example files are included with the product distribution. Working 
with these examples will demonstrate how to use AvanWaves to:

• Create a Bode plot, using the AC analysis results obtained from 
HSPICE.

• Review the results of an HSPICE transient simulation with FFT 
analysis.

Table 11-1 lists example files and locations for each analysis type.

Invoking AvanWaves

To run AvanWaves, type this command on the command line:

awaves

The About AvanWaves window displays on the screen, followed by 
the Results Display window. This is the main application window, 
which contains all the menu options and tools used in AvanWaves. 
It also is the main display window for viewing waveforms. 

AvanWaves also can be run with a number of options on the 
command line allowing you to specify the design that you want to use 
before you enter the application. In this case AvanWaves is loaded 
with the design and the environment is set up for that particular 
design. Additional setup information is provided in Chapter 2, 
“Getting Started”.

Table 11-1 Example Files

Analysis Directory File Name
TRANS and FFT $installdir/demo/awaves/tutorial/tran cpath.sp
AC $installdir/demo/awaves/tutorial/ac amc1741.sp
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Transient and FFT Analysis
This example uses AvanWaves to evaluate the results of an HSPICE 
transient simulation with FFT analysis. This example uses the 
cpath.sp design, in the $installdir/awaves/tutorial/tran/ directory.

Opening the Design

To open the cpath.sp design:

1. In the Results Display window, select Design >> Open. 

The Open Design window appears. 

2. In the Open text area, enter the following design file path name:

$installdir/demo/awaves/tutorial/tran/cpath.sp

3. Click OK. 

The Results Browser opens, listing all analysis files associated with 
this design. 

Selecting the Analysis File

The Results Browser displays the different analyses associated 
with the design. Three analysis files are available:

• A0 — typical model

• A1 — slow model

• A2 — fast model

To display a waveform, you must select an analysis file and an 
analysis type. You can then display an output waveform associated 
with that analysis in a panel by selecting it in the Results Browser, 
as shown in Figure 11-1.
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Figure 11-1 Result Browser Showing v(q6 Selected for A0

To display a curve: 

1. In the Results Browser, select the typical model, A0.

2. In the Types section, select Voltages as the analysis type.

This displays a list of all the curves associated with that type in 
the Curves area.

3. In the Curves section of the Results Browser, select the curve 
v(q6, then drag it into the Panel in the Results Display window.
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The voltage output displays versus time for five inverter sizes, as 
shown in Figure 11-2.

Figure 11-2 Results Display Window Showing Sweeps for v(q6

To select and display the curve v(q6 for analyses A1 and A2:

1. In the Results Browser, select the A1 model. The curves are 
listed for this analysis. 

2. In the Types section, select Voltages as the analysis type.

3. Select the curve v(q6, then drag it into the results display area. 

Select the A2 model, and do the same for it using the curve v(q6. 
One waveform for each analysis is now displayed in the Results 
Display window, as shown in Figure 11-3.
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Figure 11-3 Voltage v(q6 displayed for A0, A1, and A2

Sweep Filtering

You can select sweeps for highlighting, displaying, or deleting. 

To highlight a specific sweep among a set of sweeps:

1. Double-click on the waveform name associated with that sweep 
in the Wave List.

The name expands to show all of the sweeps associated with the 
waveform. 

2. Double-click on the sweep in the Wave List. 

The Results Display area highlights the specific sweep curve.

You can select the sweeps that you want displayed in the panel using 
the Sweep Filter. To display the S0 sweep for each of the three 
analyses, do the following:

• In the context-sensitive menu associated with the waveform 
display area, select Sweep Filter. 

The Sweep Filter dialog box displays, listing all sweeps for the 
waveforms, by analysis type. To show and hide sweeps in the 
panels, make selections in the Sweep Filter.
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To display the S0 sweeps on each of the three analyses, with size=1:

1. In the Sweep Filter, select all the zeros in the first column of the 
dialog box, as shown in Figure 11-4.

2. Click OK or Apply. 

The three S0 sweeps appear in the panel in the Results Display 
window, shown in Figure 11-5.

Figure 11-4 Sweep Filter with the S0 Sweeps Selected

Figure 11-5 S0 Displayed for Analyses A0, A1, and A2
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Zoom In X Feature

To zoom into the area that you want to measure along the X-axis:

1. In the context-sensitive pop-up menu, select Zoom>>Zoom In X.

2. Select the area on the X-axis from time=15 to time=25. 

The panel changes from the full design view to the selected view.

Note: To avoid the measure labels overwriting each other on the 
screen, it is recommended that you zoom into the area that 
you want to measure before you select the Measure option.

Measures

Use the Measure option to calculate the output delay difference 
between three models. To measure the delay between two points:

1. Select Measure >> PointToPoint from the main menu.

2. Move the cursor to the first point. 

3. Press and hold the left mouse button.

4. Move the cursor to the second point. 

5. Release the left mouse button. 

Now you can view the required data. You have obtained the 
differences in delay between the fast model and the typical 
model, and the differences in delay between the typical model 
and the slow model.
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Figure 11-6 Diagram Displaying the Measure Labels

FFT Analysis 

To display the frequency response of one of the elements based 
upon the FFT analysis, do the following:

1. To add a new panel to the display area, double-click Add Panel 
in the Panel List.

2. To display the Expression Builder, click the Expression 
Builder icon on the Accelerator menu, or select Tools >> 
Expressions.

3. In the Expression Builder, double-click on fftMag() in the 
Functions list to add it to the Expression definition field. 

4. In the Results Browser, select the curve v(q6 and drag it to the 
Expression definition field of the Expression Builder.

5. Assign a name to the new expression – for example, FFT. 

6. To add the new expression to the expressions list, select Apply.

7. Select the expression in the Expression list and drag it into the 
new panel in the Results Display window.
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Figure 11-7 Expression Builder Showing the Selected FFT Expression

Both time and frequency domain outputs displayed in the Results 
Display window for the chosen element, as shown in Figure 11-8.

Figure 11-8 Time and Frequency Response from FFT Simulation 
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Changing Display Parameters

Different scaling and viewing options are available in AvanWaves, 
such as linear, logarithmic, and zooming, as described below. 

1. Click in the X-axis area to display its associated pop-up menu. 

2. To change the scale of the axis from Linear to Logarithmic, select 
Logarithmic, then click Apply or OK, as shown in Figure 11-9. 

Figure 11-9 Selecting Logarithmic on the Scaling Dialog

The results display scale changes from linear to logarithmic and the 
view of the waveform in the panel changes.

Figure 11-10 Frequency Response Waveform Using Logarithmic Scale

1. To zoom into the high frequency area of the plot, select Zoom → 
Zoom In X from the context-sensitive menu in the panel. 

2. Select the range in which to zoom. 

Figure 11-11 shows the zoomed display. 
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Figure 11-11 Frequency Response Waveform After Selecting Zoom In X

Transient Analysis Summary

This example demonstrated how to evaluate the results of a transient 
and FFT Analysis using AvanWaves, which involves:

• Select specific sweeps from a group of sweeps and use the 
Sweep Filter.

• Use .OPTION MEASURE to measure the delay between 
waveforms.

• Zoom in on a section of a waveform using the Zoom In X option.

• Create expressions to view an element’s FFT frequency response.

• Change the scale of the X-axis.

AC Analysis
The next example shows how to create a Bode plot using the AC 
analysis results from an HSPICE simulation. This example uses the 
amc1741.sp design, in the $installdir/awaves/tutorial/ac directory.

To open the design, amc1741.sp, as previously described, select 
Design >> Open, and then enter the design path name: 

$installdir/demo/awaves/tutorial/ac/amc1741.sp 

The Results Browser lists all analysis files for this design. 
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Displaying Waveforms

This section shows two waveforms from the same analysis, but 
having a different type. To display two waveforms in the same panel:

1. In the Results Browser, select the AC analysis, A1.

2. In the Types section, select Volts dB for the analysis type.

A list of all curves for that type in the Curves area is displayed. 

3. In the Curves section of the Results Browser, select the 
vdb(out0 curve, then drag it into the Panel in the Results 
Display window.

Figure 11-12 Results Browser with vdb(out0 Selected
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The first waveform now displays in the panel. Now select the second 
waveform from the same analysis, but having a different data type:

1. In the Types section, select the type Volts Phase.

A list of all curves for that type in the Curves area is displayed.

2. In the Curves section of the Results Browser, select the curve 
out0 and drag it into the Panel in the Results Display window.

Figure 11-13 Display of vdb(out0 and out0 

Changing the Scale of the Display

To change the scale of the X-axis:

1. Using the right mouse button, click in the horizontal axis area to 
display the context-sensitive pop-up menu. 

2. Select the option Scale from this menu. 

A dialog box displays, to change the scale of the axis. 

3. Click the Logarithmic button to change the scale from Linear to 
Logarithmic, then click OK.
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Figure 11-14 out0 and vdb(out0) Parameters on a Logarithmic Scale

Setting the Zoom Factor

To set the zoom factor for viewing a specific section of the waveform:

1. Click in the waveform display area of the panel to display the 
context-sensitive pop-up menu. 

2. Select Set Zoom from the pop-up menu. 

The Set Local Zoom dialog displays, as shown in Figure 11-15.

3. In the Set Local Zoom dialog, set the following values for the 
variables displayed, by typing them into the text entry area:

- For Frequency, set Minimum to 1 and Maximum to 10x. 

The scale factors display in the field next to the text entry area. 
Click on the scale factors required to select it. 

To change the unit from 0 to x, in the pop-up menu, select x(6).

- For Volts Phase, set the Minimum to -20 and the Maximum 
to 120.

- For Volts dB, set the Minimum to -20 and the Maximum to 
120.

4. Click OK to apply the changes.
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Figure 11-15 Set Local Zoom Dialog

The view in the panel changes to reflect the zoom factor selected, as 
in Figure 11-16. This is the Bode plot that you specified to display.

Figure 11-16 vdb(out0 and out0 Displayed After Setting the Zoom Factor

When you use Bode plots, you generally want to measure the phase 
margin, which is the phase at 0 dB gain. 
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Measuring Unity Gain Frequency and Phase Margin 

To measure the frequency at 0 dB gain:

1. Click in the Results Display area of the Panel to display the 
context-sensitive menu.

2. Select Measure Preference >> All Values.

3. From the main menu of the Results Display window, select
Measure >> Point.

This allows you to identify points in the display area. 

4. Place the first marker on the vdB(out0 curve at Volts dB = 0. 
Note the unity gain frequency (look at the value in the X 
coordinate box on the Accelerator menu bar). 

5. Select Measure >> Point again. This time place a marker on the 
Volts Phase curve at the same X value (frequency) as the first 
marker. To ensure that you have the same X coordinate, again 
check the frequency in the X coordinate box on the Accelerator 
menu bar. 

The Y value for the second marker, the Phase at 0 dB gain, is the 
value of the phase margin. 

Figure 11-17 Bode Plot Displaying Unity Gain and Phase Margin 
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Saving the Configuration

To save the configuration, all of the displays and associated 
parameters, click Configuration >> Save and enter a name, for 
example bode, for the configuration. The aspects of the present 
analysis are saved in configuration file bode.cfg. 

To bring up the same configuration another time, you can open the 
configuration file bode.cfg, after opening the associated design. 

AC Analysis Summary

In this example you learned how to create a Bode plot from an AC 
analysis, which included:

• Changing the scale of the axes.

• Zooming in on a part of the display.

• Using the Point feature and coordinate value boxes to find the 
phase margin.

• Saving all aspects of the analysis in a configuration.
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12
Accessing Online Help 12

In AvanWaves you can get online Help on how to:

• Use a function in a particular window or dialog box, by clicking the 
Help button 

• Use a feature, command, or function available in AvanWaves, 
either by using the Help-DocSet Browser or by using the Topic 
arrow keys in each Help page.
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To access the AvanWaves online Help system, do either of the 
following:

• Click the Help button in a window or dialog box. 

The associated Help page displays. 

or 

• Position the cursor inside the window on which you want help, 
and press the F1 key. This displays the Help page for the 
currently-selected window or dialog box.

Once you are in the Help system, you can move to other topics using 
the buttons and menu options available. The Help system has two 
primary dialog boxes that are used to find a desired topic, the Help 
page and the Help-DocSet Browser. These two windows are 
described in the following sections. 
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Help Page
A Help page opens when you ask for Help on a particular topic. The 
Help page contains help for the requested, topic, feature, function, 
procedure, or command description (see Figure 12-1) 

Table 12-1 Pop-Up Menu Buttons on Help Pages

Button Description

File Enables you to open and close Help pages as you need them. You 
can select the Table of Contents, which is a general index to all 
the topics available in Help.

Edit Not implemented for this release.

Bookmarks Enables you to put markers in a document in areas of specific 
interest to you, and keeps a list of these markers so that you can 
return to a particular topic at a later time.

History Lists the five most recent topics and subtopics that you have 
viewed during the current Help session. You can use this list to go 
back to a topic and navigate faster between topics of interest.

Help Provides information on the Galaxy product that is used to 
implement the Help system.
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Figure 12-1 Help Page

Section Menu

The Section pop-up menu displays a list of the Help topics 
associated with the currently selected topic. The list always contains 
the parent of the topic selected and the selected topic. At the top 
level, the list contains all entries under the parent topic. 

To select a topic from the list, click on the Section menu button, then 
click on the desired topic in the list. The Help page displays Help for 
the selected topic. 
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Topic Selection Arrows

The Topic selection arrows are at the bottom of each Help page and 
dialog box. To step through the Help topics listed on the Help-
DocSet Browser, click on the arrow in the direction that you want to 
move on the Help-DocSet Browser list. The previous or next topic 
on the Help-DocSet Browser displays in the Help page.

The most convenient way to navigate through Help topics is to use 
the Help-DocSet Browser, since it provides you with a complete list 
of all the topics and subtopics on which you can get help. 

You can access the Help-DocSet Browser through the File menu in 
the Help page. Select File >> Table of Contents, which displays the 
Help-DocSet Browser. Double-click on a topic in the list to get Help 
on that topic. See the description of how to use the Help-DocSet 
Browser below. 

Bookmarks

The Bookmark menu allows you to mark a topic to be included in 
the list of bookmarks. These are points of reference in the Help 
system to which you can return at any time during the current 
AvanWaves session. You also can clear bookmarks that have been 
set.

• To insert a Bookmark, select Bookmarks >> Mark Here. 

This adds the currently-displayed topic to the Bookmarks List, 
which is appended onto the Bookmarks menu.

• To display a topic marked by a Bookmark, select the Bookmarks 
menu and one of the Bookmarks listed in this menu. 

The contents of the Help page update to reflect the selection.
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• To delete a Bookmark:

1. Select Bookmarks >> Edit. 

The Bookmark Editor displays. 

2. Select the bookmark that you want to delete from the list.

3. Select Edit >> Clear.

This removes the Bookmark from the list.

• To exit from the online Help system, select File >> Close 
Browser from the Help page menu.

Help-DocSet Browser

When you first open the Help-DocSet Browser, the entry displayed 
in the current Help page is highlighted in the Entries list (See Figure 
12-2). If you open another Help page or select help on another topic, 
the entry selection in the Help-DocSet Browser is updated to reflect 
the most current selection. Only one Help-DocSet Browser can be 
opened at a time.

Selecting File >> Table of Contents in another Help page updates 
the current Help-DocSet Browser to reflect the contents of the 
currently selected Help page.
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Figure 12-2 Help-DocSet Browser

Using the Entries List to Get Help

You can get help on any topic or subtopic from the Entries list. Use 
the scroll bar to scroll through the list of available Help topics.

To get help on a new topic or subtopic:

1. Select the entry you want from the Entries list. 

2. Double-click on the entry. 

The entry you selected is displayed in the Help page.
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Using Search to Get Help 

You can search for help on a particular topic by using the Search 
menu, or by entering keywords directly into the Search field and then 
clicking the Search button. You can type an entry directly into the 
Search field and click Search to search for it. 

To search based on keywords:

1. Select Search >> List Keywords from the menu to display the 
Keywords List.

2. Double-click on a keyword in this list to enter it into the search 
field. 

You can enter multiple search criteria by continuing to double-
click on keywords in the Keyword List. The keywords are 
automatically entered in succession into the Search field. 

3. Click Search to search for the Entries specified.

If the search is unsuccessful and does not return any topics, clear 
the Search field and press Return to display the full list of Help 
topics. 

If the search is successful, the list of relevant topics are displayed 
in the Entries section of the Help-DocSet Browser. Double-click 
on an entry to display the Help for that entry.
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Command Summary A

This appendix contains a summary of the commands available in 
AvanWaves.
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Table A-1 Command Summary (Sheet 1 of 7)

Menu Command Description

Design → 
Open...

Opens a dialog box listing paths to designs that 
can be opened and used in your analysis.

→ History Lists the last five designs opened during the 
current AvanWaves session.

→ Special → Home Returns you to your home directory.

→ Special → Mark Marks a directory location for the history list.

→ Special → Unmark Removes the current directory location from the 
marked list.

→ View → by Name Lists the files by name in alphabetical order.

→ View → by Date 
Modified

Lists the files according to the last date they were 
modified.

→ View → by Date 
Created

Lists the files by the date they were created.

→ Filter → Input Displays the input files only.

→ Filter → Listing Displays the listing files only.

→ Filter → Raw Output Displays raw data files only (HSPICE graph data 
files).

→ Filter → Measures Displays measure data files only.

→ Filter → All Files Displays all the files in the current directory.

→ Filter → Optionsº Displays files with a particular input or output 
suffix.

Design → Closeº Closes the selected design from the list of 
designs in the Close Design dialog.

→ Currentº Displays the path to the currently active design 
(the design that is open in the Results 
Browser).

→ Exit Exits from the current AvanWaves session, 
saving the display to a configuration, if the option 
is selected.
A-2
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Panels → Add Adds a new panel to the display area and lists it 
in the Panel List.

→ Hide Closes the selected panel.

→ Delete Panel Removes the selected panel from the display 
area and removes the panel name from the 
Panel List. The Delete command works on a 
selected Panel and also by selecting the panel 
name in the Panel List.

→ Delete Curves Removes the currently selected curve from the 
panel and the name of the curve and the 
associated sweeps from the Wave List.

→ Update Updates the currently displayed panels with the 
most recent information from your design files.

→ Add Label Displays a Label dialog box for entering the text 
for a label to place in a panel.

→ Delete Label Removes the selected label from the panel.

→ Stacked/Overlay 
Mode

Toggles between stacked waveform mode and 
overlaid waveform model in the selected 
panel(s).

Window → Full Displays the full view of the waveforms displayed 
in a panel.

→ Zoom In X Zooms into a selected area of the panel in 
relation to the X-axis.

→ Zoom Out X Zooms out from a selected area of the panel in 
relation to the X-axis.

→ Zoom In Y Zooms into a selected area of the panel in 
relation to the Y-axis.

→ Zoom Out Y Zooms out from a selected area of the panel in 
relation to the Y-axis.

→ Zoom In X/Y Zooms in any direction into a selected area of the 
panel.

→ Zoom Out X/Y Zooms in any direction out of a selected area of 
the panel.

Table A-1 Command Summary (Sheet 2 of 7)

Menu Command Description
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Window → Last Zoom Displays the previous zoom selection in the 
panel.

→ Set Zoom Allows you to set scale X and Y values to define 
the limits of the display window. For the field 
following the numeric values select units from a 
range of milli to tera.

→ Pan X Moves the waveform view in relation to the X-
axis by the amount specified.

→ Pan Y Moves the waveform view in relation to the Y-
axis by the amount specified.

→ Pan X/Y Moves the waveform view in any direction by the 
amount specified.

Measure → Point Identifies a selected point on a waveform.

→ PointToPoint Measures the distances between two points 
selected on a waveform (“deltaX” and “deltaY”) 
and the slope between the two points. The 
measurements label appears adjacent to the 
final point.

→ Delete Measure Deletes the selected measure from the panel 
display.

→ Delete All Measure Removes all measure values from the panel 
display.

Measure → 
Measure Label 
Options

Title Allows a user title to be entered into a field of this 
window. This title subsequently appears in each 
measurement label.

X1 Causes the X-coordinate of the initial point to be 
displayed for a PointToPoint measurement.

Y1 Causes the Y-coordinate of the initial point to be 
displayed for a PointToPoint measurement.

Current X Displays the X-value for a Point measurement. 
This value is shown for the last point of a 
PointToPoint measurement.

Current Y Displays the Y-value for a Point measurement. 
This value is shown for the last point of a 
PointToPoint measurement.

Table A-1 Command Summary (Sheet 3 of 7)

Menu Command Description
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Measure → 
Measure Label 
Options

Delta X Displays the X-increment for a PointToPoint 
measurement.

Delta Y Displays the Y-increment for a PointToPoint 
measurement.

Slope Displays slope = delta Y/delta X for a 
PointToPoint measurement.

Derivative Displays dy/dx for a single point or for the last 
point of a PointToPoint measurement.

Hide Causes subsequent labels to be hidden. They 
can be displayed later by resetting Hide.

Orientation Determines where the label window appears 
with respect to the measure point. Select one of 
four options: NW, NE, SW, or SE.

Measure → 
Measure 
Preferences 

Set Snap → Data Point Allows measurements only between data points 
on a waveform.

Set Snap → All Values Allows measurements on all parts of the 
waveform.

Set Lock → All Angle Measurement operations can be performed at 
any angle.

Set Lock → Lock Vertical 
At first point

Measurement operations can only be performed 
in the X direction.

Set Lock → Lock 
Horizontal At first point

Measurement operations can only be performed 
in the Y direction.

Set Lock → Lock Vertical 
At X Value

Measurement operations can only be performed 
in the X value specified in the first measure point.

Set Lock → Lock 
Horizontal At Y Value

Measurement operations can be performed only 
in the Y value specified in the first measure point.

→ Precision Sets the precision of the value obtained from 
measure operations.

→ Anchor Cursor Drops a pair of anchored cursors.

Table A-1 Command Summary (Sheet 4 of 7)

Menu Command Description
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Measure → 
Measure 
Preferences

→ Remove Cursor Removes the selected pair of anchored cursors.

→ Anchor cursor Displays an anchored cursor showing x and y 
values.

→ Remove Anchor Removes the existing anchor.

Configuration → Openº Opens a configuration that you saved.

→ Saveº Saves the current panel and analysis 
environment as a configuration.

 → Deleteº Removes a selected configuration from the list of 
saved configurations.

Tools → Results Browserº Displays the Results Browser containing the 
currently active design analysis files. This is the 
same as clicking on the Results Browser icon 
on the accelerator menu.

→ Expressions Displays the Expression Builder, which 
contains the functions and operators to be used 
in creating expressions and macros in 
AvanWaves. This is the same as clicking on the 
Expression Builder icon on the accelerator 
menu.

Tools 
→ Expressions 
→ Macro 

→ Add Macroº Displays a dialog for creating macros to use in 
expressions.

→ Edit Macroº Displays a dialog allowing you to edit the Macro.

→ Load Macroº Displays a dialog for loading a saved Macro.

→ Save Macroº Saves a Macro for future use.

Tools 
→ Load Macroº
→ Save Macroº

→ History Last five designs opened in the current 
AvanWaves session, which you can open.

→ Special → Home Returns you to your home directory.

→ Special → Mark Marks a directory location for the History list.

→ Special → Unmark Removes the current directory location from the 
marked list.

→ View → by Name Lists the files by name in alphabetical order.

Table A-1 Command Summary (Sheet 5 of 7)

Menu Command Description
A-6

Command Summary:



Tools 
→ Load Macroº
→ Save Macroº

→ View → by Date 
Modified

Lists files according to the last date they were 
modified.

→ View → by Date 
Created

Lists files by the date they were created.

→ Filter → Macro 
Definitions

Lists files that contain Macro definitions.

→ Filter → All Files Lists all files in the design.

Tools → Print
→ Print button 

→ History Lists the last five designs opened during the 
current AvanWaves session that can be selected 
and opened.

→ Special → Home Returns you to your home directory.

→ Special → Mark Marks a directory location for the History list.

→ View → by Name Lists the files by name in alphabetical order.

→ View → by Date 
Modified

Lists files according to the last date they were 
modified.

→ View → by Date 
Created

Lists files by the date they were created.

→ Filter → PostScript Lists files that are in PostScript format.

 → Filter → Encapsulated 
PostScript

Lists all encapsulated PostScript files.

→ Filter → All Files List all files.

Tools 
→ Preferencesº

Opens the Select Preferences dialog for setting 
personal application preferences.

→ File → Close Window Closes the Select Preferences window.

→ Edit → Selected Displays the Set Analysis Preferences dialog 
for setting waveform and symbol preferences.

→ Edit → Application → 
About

Displays the AvanWaves About box.

→ Edit → Application → 
General

Displays the Set General Preferences dialog 
for setting the foreground and background color 
and the font used by the application.

→ Edit → Analysis → 
Curves

Displays Set Analysis Preferences dialog that 
controls waveform display attributes.

Table A-1 Command Summary (Sheet 6 of 7)

Menu Command Description
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Help Opens the AvanWaves on-line Help system.

Set Zoom Displays the Set Zoom dialog for setting the 
zoom factor for zooming in and out of selected 
areas in a panel.

Set Pan Displays the Set Pan dialog for setting values for 
panning in a panel.

Set Grid Displays the Set Grid dialog for setting the 
location of the first vertical grid line, and the 
spacing between vertical grid lines, in your 
waveform display.

Monotonic/
Continuous Plot

Selects a monotonic or continuous waveform in 
the panel.

Sweep Filter Displays a dialog box containing the sweeps 
associated with the waveforms in the selected 
panel. Sweeps can be selected or deselected for 
viewing by clicking on them.

Scale → Linear Selects a linear scale.

→ Logarithmic Selects a logarithmic scale.

Table A-1 Command Summary (Sheet 7 of 7)

Menu Command Description
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B
Operators and Functions B

This appendix lists the operators and functions currently available in 
AvanWaves.
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Operators

You can use the following operators in expressions in AvanWaves.   

Table B-1 Arithmetic Operators

Operator Function Description

+ Addition

- Subtraction

* Multiplication

/ Division

Table B-2 Comparison Operators (Return 0 or 1 Values)

Operator Function Description

> Greater than

< Less than

<= Greater than or equal to

>= Less than or equal to

!= Not equal to

== Equal

Table B-3 Boolean Operators (Return 0 or 1 Values)

Operator Function Description

&& Performs the AND operation. 

• Returns 1 if both values are nonzero.
• Returns 0 otherwise.

|| Performs the OR operation. 

• Returns 1 if either value is nonzero.
• Returns 0 otherwise.

! Performs the NOT operation. 

• Returns 1 if its argument is 0.
• Returns 0 otherwise.
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Predefined Functions 
You can use the functions in Table B-5 in expressions in AvanWaves.

Table B-4 Conditional Operator

Operator Function Description

<expr1> ? 
<expr2> : 
<expr3>

<expr1>, <expr2>, and <expr3> are expressions. If the result 
of <expr1> is nonzero, then the result of <expr2> is returned, 
otherwise the result of <expr3> is returned. 

Table B-5 List of Predefined Functions

Function Description
abs(x) Returns the absolute value of x, |x|.
atan(x) Returns the arctangent of x (radians).
atan2(y,x) Returns the arctangent of y/x between -pi and pi.
cos(x) Returns the cosine of x (radians).
cosh(x) Returns the hyperbolic cosine of x (radians).
decibel(x) Returns the base 10 logarithm of the absolute value of x, 

multiplied by 20, with the sign of x: (sign of x)20log10(|x|).
derivative (curve) Returns the derivative of the curve.
exp(x) Returns e raised to the power x, ex.

fftImag(curve, start, stop, 
numpoints, window, alpha)

Returns the imaginary components of a Fast Fourier 
Transform. Start and stop must be specified as real 
decimal numbers, for example: 0.0000000.

fftMag(curve, start, stop, 
numpoints, window, alpha)

Returns the magnitude of a Fast Fourier Transform: 
fftMag(curve, start, stop, window, alpha) = 
mag((fftReal(curve, start, stop,window, alpha), 
fftImag(curve, start, stop, window, alpha)) start and stop 
must be specified as real decimal numbers.

fftPhase(curve, start, stop, 
numpoints, window, alpha)

Returns the phase of a Fast Fourier Transform:

fftPhase(curve, start, stop,window, alpha) =

phase((fftReal(curve, start, stop,window, alpha), 
fftImag(curve, start, stop, window, alpha)) start and stop 
must be specified as real decimal numbers.

fftReal(curve, start, stop, 
numpoints, window, alpha)

Returns the real components of a Fast Fourier Transform 
Start and stop must be specified as real decimal numbers.

imag(mag,ph) Converts polar to rectangular form:

imag(mag,ph) = mag * sin(ph).
integer(x) Returns the integer portion of x (truncates decimal portion).
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FFT Parameters
HSPICE FFT simulation uses double precision floating point 
numbers, compared with the single precision floating point of the 
Graph data files in normal simulation.

Table B-6 lists parameters used with FFT functions in AvanWaves.

Note: The AvanWaves equivalent to the HSPICE .FFT simulation is 
the fftMag function.

integral(curve) Returns the integral of the curve.
log(x) Returns the natural logarithm of the absolute value of x, 

with the sign of x: (sign of x)log(|x|).
log10(x) Returns the base 10 logarithm of the absolute value of x, 

with the sign of x: (sign of x)log10(|x|.

mag(y,x) Converts from rectangular to polar form: sqrt(y*y+x*x).
max(x,y) Returns the numeric maximum of x and y.
min(x,y) Returns the numeric minimum of x and y.
phase(y,x) Converts from rectangular to polar form: returns the 

arctangent of y/x between -180 and 180 (degrees).
pow(x,y) Returns x to the power y.
real(mag,ph) Converts polar to rectangular form: 

real(mag,ph) = mag * cos(ph).
sin(x) Returns the sine of x (radians).
sinh(x) Returns the hyperbolic sine of x (radians).
sqrt(x) Returns the square root of the absolute value of x: sqrt(-x) 

= -sqrt(|x|).
tan(x) Returns the tangent of x (radians).

Table B-5 List of Predefined Functions (Continued)

Function Description
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In FFT analysis, windows are frequency-weighting functions applied 
to the time domain data to reduce spectral leakage associated with 
finite-duration time signals. Windows are smooth functions that peak 
in the middle frequencies and decrease to zero at the edges. This 
reduces the effects of discontinuities caused by periodic extension. 

Table B-7 lists the common performance parameters for FFT 
windows available in HSPICE. 

Table B-6 FFT Statement Parameters

Parameter Default Description
output_var — Can be any valid output variable, such as voltage, current, or 

power
START See 

Description
Specifies the beginning of the output variable waveform to be 
analyzed. Defaults to the START value in the .TRAN statement, 
which defaults to zero seconds. Specify this value as a real, 
decimal number, for example 0.00000001. Invalid specification 

examples are: 10n, 10ns, 1.0 e-8.
STOP See 

Description
Specifies the end of the output variable waveform to be analyzed. 
Defaults to the TSTOP value in the .TRAN statement.

NP 1024 Specifies the number of points used in the FFT analysis. NP must 
be a power of 2. If NP is not a power of 2, HSPICE automatically 
adjusts it to the closest higher number that is a power of 2.

WINDOW RECT Specifies the window type to use:

RECT=simple rectangular truncation window
BART=Bartlett (triangular) window
HANN=Hanning window
HAMM=Hamming window
BLACK=Blackman window
HARRIS=Blackman-Harris window
GAUSS=Gaussian window
KAISER=Kaiser-Bessel window

ALFA 3.0 Specifies the parameter used in GAUSS and KAISER windows to 
control the highest side-lobe level, bandwidth, and so on.

1.0 <= ALFA <= 20.0
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Refer to HSPICE Application Note 6144, “FFT Spectrum Analysis,” 
for more information about FFT windows and FFT simulations.

Table B-7 Window Weighting Characteristics in FFT Analysis

Window Equation Highest Side-
Lobe (dB)

Side-Lobe 
Roll-Off
(dB/octave)

3.0-dB 
Bandwidth
(1.0/T)

Worst Case 
Process 
Loss (dB)

Rectangular W(n)=1,

0 ≤ n < NP†
-13 -6 0.89 3.92

Bartlett W(n)=2n/(NP−
1), 0 ≤ n ≤ (NP/2)−1 
W(n)=2−2n/(NP−
1),NP/2 ≤ n < NP

-27 -12 1.28 3.07

Hanning W(n)=0.5−
0.5[cos(2πn/(NP−
1))],0 ≤ n < NP

-32 -18 1.44 3.18

Hamming W(n)=0.54−
0.46[cos(2πn/(NP−
1))],0 ≤ n < NP

-43 -6 1.30 3.10

Blackman W(n)=0.42323−
0.49755[cos(2πn/
(NP−1))]
+0.07922cos[cos(4π
n/(NP−1))],
0 ≤ n < NP

-58 -18 1.68 3.47

Blackman-
Harris

W(n)=0.35875−
0.48829[cos(2πn/
(NP−1))]
+0.14128[cos(4πn/
(NP−1))]−
0.01168[cos(6πn/
(NP−1))],
0 ≤ n < NP

-92 -6 1.90 3.85

Gaussian

α=2.5

α=3.0

α=3.5

W(n)=exp[−
0.5α2(NP/2−1−n)2/

(NP)2],
0 ≤ n ≤ (NP/2)−1

W(n)=exp[−0.5α2(n−
NP/2)2/(NP)2],NP/2 
≤ n < NP

-42

-55

-69

-6

-6

-6

1.33

1.55

1.79

3.14

3.40

3.73
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†NP is the number of points used for the FFT analysis.

Kaiser-
Bessel

α=2.0

α=2.5

α=3.0

α=3.5

W(n)=I0(x2)/I0(x1)

x1=πα
x2=x1*sqrt[1−(2(NP/

2−1−n)/NP)2],
0 ≤ n ≤ (NP/2)−1

x2=x1*sqrt[1−(2(n−

NP/2)/NP)2],
NP/2 ≤ n < NP

I0 is the zero-order 
modified Bessel 
function

-46

-57

-69

-82

-6

-6

-6

-6

1.43

1.57

1.71

0.89

3.20

3.38

3.56

3.74

Table B-7 Window Weighting Characteristics in FFT Analysis (Continued)

Window Equation Highest Side-
Lobe (dB)

Side-Lobe 
Roll-Off
(dB/octave)

3.0-dB 
Bandwidth
(1.0/T)

Worst Case 
Process 
Loss (dB)
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C
Terms and Naming Conventions C

This appendix provides the AvanWaves terms (see Table C-1) and 
naming conventions (see Table C-2).
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Table C-1 Glossary of AvanWaves Terms

Term Definition

Analysis The execution of a particular type of simulation — for example, AC, 
DC, or transient analysis. A number of analysis can be performed on 
each run. 

Continuous Plot A graph that has points connected in all directions, both positive and 
negative.

Curves The output waveforms for variables simulated in HSPICE.

Design The collective information that describes your circuit, such as the 
analysis files, the netlist, the graph data files, and so on. AvanWaves 
provides a graphical representation of your circuit design.

Graph The graphical representation of the results derived from a simulation 
run, also known as a waveform or curve. A graph is displayed inside a 
panel. 

Graph data file The HSPICE output data files from either sweeps or measures.

HSPICE Avan-Software’s circuit simulator

Monotonic Plot A graph that has points connected in the X direction only

Panel Contains all of the information about an analysis in graphical form. A 
panel has a title, a wave display area, an X-axis and Y-axis, and a 
Wave List. The number of panels displayed is limited by the window 
size. 

Results Browser The dialog box containing a list of all simulation results available for the 
current design

Run files Files resulting from an HSPICE simulation run.

Sweep A set of simulation output data with parametric variation. In HSPICE, 
known as an “outer loop sweep”.

Sweep Filter The filter is used to limit the number of data points displayed in the 
curves area to those that you specifically require.

Wave Display area The area of a panel in which waveforms are displayed. 

Waveform Plotted data from a simulation.

Waveform Display The graphical display area inside a panel.

Wave List A list of the currently displayed waveforms.
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Table C-2 AvanWaves Naming Conventions

Name Convention

Analysis Analyses are represented by Analysis numbers, A0 through An. Each 
analysis has a unique number that acts as an identifier for that analysis.

Configuration Configurations have names assigned by users. They are saved in files of 
the form <config_name>.cfg. 

Design Designs are represented by a design number, D0 through Dn. Each 
design has a unique number that acts as an identifier for that design.

Expression Expressions consist of a name and definition that you specify. The 
definition includes functions, macros and their arguments, and operators.

Macro Macros have file names that you assign, in the form <macro_name>.mac. 
You must define macro parameters when you create the macro. 

Panel All panels have default names such as Panel1, Panel2, and so on. The 
number indicates the order in which the panels were opened. You can 
change panel names. 

Sweep Sweeps are represented by sweep numbers S0 through Sn. Each sweep 
has a unique number that acts as an identifier for that sweep.

Waveforms Waveform names can be no longer than sixteen characters in length. This 
covers the HSPICE limit for relative waveform names.
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Index

A
A0 through An, analysis label 4-5
AC analysis 11-1, 11-12, 11-18
.ac file 1-4, 3-6
accelerator 4-9
accelerator icon 4-9
add

label 4-12
algebraic expression 6-4
analysis

AC 11-1, 11-12, 11-18
FFT 11-1, 11-3, 11-9
FFT, window weighting B-6
label 4-5
transient 11-1, 11-3
type, dB 11-13
type, Volts 11-13
type, Volts Phase 11-14

analysis preference
color 4-34
continuity 4-34
line style 4-34
symbol 4-34
symbol frequency 4-34

Anchor A-5
Anchor Cursor A-5
arithmentic operator 6-4

B
batch job list, MS Windows launcher 10-6
Bode plot 11-2, 11-12, 11-18
Boolean operator 6-4
browser

hierarchy 4-5
results 4-4

builder, macro 4-4

C
.cfg extension 1-4
changing views 5-2
chooser

line style 4-38
symbol 4-37

close design window 3-7
color 4-34

background and foreground 8-6
waveform 4-12, 8-3

command line
syntax 4-2

conditional operator 6-4
configuration 4-10, 7-1

delete 7-4
file, HSPICE 1-4
MS Windows launcher 10-4
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configuration (continued)
open 7-3
save 3-9, 11-18
saving 7-2

context sensitive menu 4-8, 4-13, 4-14
continuity 4-34
continuity, setting display 8-4
current design window 3-8
current X-axis 4-7
curve

area 4-7
scroll list 4-7

customizing the environment 8-1

D
data

sweep 6-2
types 4-6

data point symbol 8-3
dc analysis, HSPICE 2-3
delete

configuration 7-4
label 4-13

delta X 5-12
delta Y 5-12
demo 2-2
<design>

files 4-5
See also file

design
commands, MS Windows launcher 10-3
exit 3-9
file 3-6
flow 1-3
menu 3-1
number 3-8
opening 11-3

dialog, print 4-24

directory
run 3-3
structure 10-2

display
continuity, setting 8-4
parameters 11-11
scale, set 11-14
waveform 2-5
X-axis 4-11
Y-axis 4-11
zoom, set 11-15

display window, results 4-4

E
editing HSPICE source file 9-4
editor, notepad.exe 10-4
environment

customizing 8-1
variable, METAHOME 10-4

examples 11-1
exit design 3-9
expression

algebraic 6-4
creating 4-4, 6-1
editing 6-5
field 4-16
list 4-17

expression builder 4-10, 4-15, 6-1
expression field 4-16
expression list 4-17
function 4-15
function list 4-17
macro 4-15
macro list 4-18
operator 4-15
operator list 4-17
result field 4-17
variable 4-15

expression handler 4-4
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F
FFT 11-12

analysis 11-1, 11-3, 11-9
analysis, frequency response 11-9
analysis, window weighting B-6
parameter description B-4

field
expression 4-16
result 4-17

file
.ac 1-4, 3-6
ac analysis measurement results 1-4, 3-7
ac analysis results 1-4, 3-6
analysis 2-4
.cfg 1-4
dc analysis measurement results 1-4, 3-6
dc analysis results 1-4, 3-6
design 3-6
extensions submenu 3-5
hspui.cfg 10-2, 10-4
.lis 3-6, 4-5, 9-3, 10-4
.ma 1-4, 3-7
.ms 1-4, 3-6
.mt 1-4, 3-6
netlist 1-4, 3-6, 9-3, 10-3, 10-4
output listing 3-6, 9-3, 10-4
output listing, viewing 9-5
.pa0 4-5
.sp 1-4, 3-6, 9-3, 10-3, 10-4
.st 3-6
status 3-6
.sw 1-4, 3-6
.tr 1-4, 3-6
transient analysis results 1-4, 3-6
transient measure data 1-4, 3-6
type,filter menu 3-5
versions.txt 10-2

filter
menu 3-5
menu, file type 3-5
select 4-7
sweep 4-4, 4-23

font, setting 8-5

frequency
margin, measure 11-17
response, FFT

analysis 11-9
function 4-15, 6-3

list 4-17, 6-3
mathematical B-3
predefined 6-1

G
general preferences 8-5
grid

set 4-30
GridSpace 4-30
GridStart 4-30

H
handler, expression 4-4
help, on line 12-1

bookmark 12-5
entries list 12-7
keyword 12-8
search 12-8
table of contents 12-5

hidden panel 2-6, 4-12
hierarchy

browser 4-5
subcircuit 4-5

history menu 3-3
hotkeys 4-39
HSPICE 9-2

dc analysis 2-3
editing source file 9-4
input netlist 1-4, 3-6, 9-3, 10-3, 10-4

hspui.cfg 10-2, 10-4

I
icon, accelerator 4-9
identifier, waveform 4-12
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K
keyboard shortcuts 4-39

L
label, analysis 4-5
launcher

MS Windows 10-2
MS Windows, design commands 10-3

line style 4-34, 8-4
line style chooser 4-38
linear 11-11
.lis file 3-6, 9-3, 10-4
list

expression 4-17
function 4-17
macro 4-18
operator 4-17
scroll 4-5
wave 4-8

listing file 3-6, 9-3, 10-4
logarithmic 11-11

M
.ma file 1-4, 3-7
macro 4-15, 6-8

builder 4-4
creating 4-4, 6-1
displaying 6-10
list 4-18
loading 6-12
menu 4-18

manager, window 2-2
measure 11-12

label options 5-12
margin, frequency 11-17
margin, phase 11-17
menu 5-8

measure (continued)
options 5-10
point 4-10, 5-8
point to point 4-10, 5-8
preference 4-15
preference, snap mode 5-10

menu
bar 4-8, 4-9
configuration 4-9
configuration, MS Windows launcher 10-4
context sensitive 4-8, 4-10, 4-13, 4-14
design 3-1, 4-9
filter 3-5
help 4-9
history 3-3
macro 4-18
measure 4-9, 5-8
measure, preference 4-15
panel 4-9
pop up 4-10
special 3-4
tool 4-9, 4-12
tool, preference 4-12
window 4-9, 4-15

set zoom 4-15
window, preference 5-10

Motif 2-2
.ms file 1-4, 3-6
MS Windows launcher 10-2

batch job list 10-6
multi jobs 10-5
required files 10-2

.mt file 1-4, 3-6
multi select 4-6

N
navigate 3-3
notepad.exe 10-4
number, design 3-8
numeric comparison operator 6-4
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O
on line help 12-1
one point measure 4-10
open

configuration 7-3
design 3-2, 11-3

operations, global 5-2
operator 4-15, 6-1

arithmetic 6-4
Boolean 6-4, B-2
comparison B-2
conditional 6-4, B-3
numeric comparison 6-4

operator list 4-17
option

measure 5-10, 11-12
scale 11-11
scale, linear 11-11
scale, logarithmic 11-11
scale, zoom 11-11
view 3-4, 11-11
view, linear 11-11
view, logarithmic 11-11
view, zoom 11-11

output listing file 3-6, 9-3, 10-4

P
pan X 5-6
pan Y 5-6
panel 4-10

add label 4-12
configuration 4-10
context sensitive pop-up 4-10
delete label 4-13
deleting 4-11
hidden 2-6, 4-12
name 4-11
name changing 4-11
print 4-24
results display 4-8
wave list 4-13
waveform 4-10

panel (continued)
waveform display 4-11
X-axis 4-11
Y-axis 4-11

performing measurements 5-8
personal preference 8-1
phase margin 11-18
phase margin, measure 11-17
predefined function 6-1, B-3
preference

analysis 4-34
analysis, setting 8-3
application 4-4
attribute 4-4
color 4-32, 4-33
continuity 4-32
data point 4-32
font 4-33
general 8-5
measure 4-15, 5-10
option 4-12
personal 8-1
run manager 9-3, 9-6
symbol type 4-32

print 4-4
dialog 4-24
manager 4-10
to file 4-25
to printer 4-25

R
range select 4-6
Remove Cursor A-6
result

ac analysis 1-4, 3-6
ac analysis measurement 1-4, 3-7
dc analysis 1-4, 3-6
dc analysis measurement 1-4, 3-6
field 4-17
transient analysis 1-4, 3-6
transient measure data 1-4, 3-6

results browser 4-4, 4-10
results display window 2-4, 4-4
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run
directory 3-3
file, HSPICE 1-4
HSPICE 9-4
manager 9-1
manager, preferences 9-3, 9-6

run HSPICE 9-4

S
.sav directory 1-4
save configuration 3-9, 11-18
scale

display, set 11-14
linear 4-14
logarithmic 4-14
X-axis 4-11
Y-axis 4-11

scroll list 4-5
select

filter 4-7
multi 4-6
range 4-6

set
analysis preferences 8-3
background color 8-6
display

continuity 8-4
display scale 11-14
display zoom 11-15
font 8-5
foreground color 8-6
general preferences 8-5
grid 4-30
line style 8-4
symbol frequency 8-5
symbol type 8-4

set zoom 4-15, 4-27
shortcuts, keyboard 4-39
simulate button 10-4
.sp file 1-4, 3-6, 9-3, 10-3, 10-4

special menu 3-4
speed bar 4-8, 4-9
.st file 3-6
Stacked/Overlay Mode A-3
status file 3-6
subcircuit

hierarchy 4-5
.sw file 1-4, 3-6
sweep 11-12

data 6-2
filter 4-4, 4-15, 4-23, 11-6

sweeps 11-6
symbol 4-34

data point 8-3
frequency 8-5
type 8-4

symbol chooser 4-37
syntax, command line 4-2

T
tool

description 4-4
menu 4-12
preferences 8-2
run HSPICE 9-2

.tr file 1-4, 3-6
transient 11-12
transient analysis 11-1, 11-3
two point measure 4-10
type

analysis, dB 11-13
analysis, Volts 11-13
analysis, Volts Phase 11-14
list 4-6

U
using measures 11-8
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V
variable 4-15
variable, environment, METAHOME 10-4
versions.txt 10-2
view option 3-4
viewing output listing file 9-5
views, changing 5-2

W
wave list 4-8, 4-13
waveform 4-10

color 4-12, 8-3
display 2-5
display area 4-11
identifier 4-12

window
close design 3-7
current design 3-8
global operations 5-2
manager 2-2
menu 5-2
open design 3-2
set zoom 4-27

X
X-axis 4-11, 4-13

current 4-7
default 4-7
display 4-11
scale 4-11

X-Y coordinate display 4-9

Y
Y-axis 4-11, 4-13

display 4-11
scale 4-11

Z
zoom 11-11

display, set 11-15
in 4-10, 5-2
out 4-10, 5-3
set 4-15, 4-27
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